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Copyright
Copyright © 2007 Nokia. All rights reserved.

Reproduction, transfer, distribution or storage of part or all of the contents in this document in any form
without the prior written permission of Nokia is prohibited.

Nokia, Nokia Connecting People, and Nokia X and Y are trademarks or registered trademarks of Nokia
Corporation. Other product and company names mentioned herein may be trademarks or tradenames of
their respective owners.

Nokia operates a policy of continuous development. Nokia reserves the right to make changes and
improvements to any of the products described in this document without prior notice.

Under no circumstances shall Nokia be responsible for any loss of data or income or any special, incidental,
consequential or indirect damages howsoever caused.

The contents of this document are provided "as is". Except as required by applicable law, no warranties of
any kind, either express or implied, including, but not limited to, the implied warranties of merchantability
and fitness for a particular purpose, are made in relation to the accuracy, reliability or contents of this
document. Nokia reserves the right to revise this document or withdraw it at any time without prior notice.

The availability of particular products may vary by region.

IMPORTANT
This document is intended for use by qualified service personnel only.
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Warnings and cautions

Warnings
• IF THE DEVICE CAN BE INSTALLED IN A VEHICLE, CARE MUST BE TAKEN ON INSTALLATION IN VEHICLES FITTED

WITH ELECTRONIC ENGINE MANAGEMENT SYSTEMS AND ANTI-SKID BRAKING SYSTEMS. UNDER CERTAIN FAULT
CONDITIONS, EMITTED RF ENERGY CAN AFFECT THEIR OPERATION. IF NECESSARY, CONSULT THE VEHICLE DEALER/
MANUFACTURER TO DETERMINE THE IMMUNITY OF VEHICLE ELECTRONIC SYSTEMS TO RF ENERGY.

• THE PRODUCT MUST NOT BE OPERATED IN AREAS LIKELY TO CONTAIN POTENTIALLY EXPLOSIVE ATMOSPHERES,
FOR EXAMPLE, PETROL STATIONS (SERVICE STATIONS), BLASTING AREAS ETC.

• OPERATION OF ANY RADIO TRANSMITTING EQUIPMENT, INCLUDING CELLULAR TELEPHONES, MAY INTERFERE
WITH THE FUNCTIONALITY OF INADEQUATELY PROTECTED MEDICAL DEVICES. CONSULT A PHYSICIAN OR THE
MANUFACTURER OF THE MEDICAL DEVICE IF YOU HAVE ANY QUESTIONS. OTHER ELECTRONIC EQUIPMENT MAY
ALSO BE SUBJECT TO INTERFERENCE.

• BEFORE MAKING ANY TEST CONNECTIONS, MAKE SURE YOU HAVE SWITCHED OFF ALL EQUIPMENT.

Cautions
• Servicing and alignment must be undertaken by qualified personnel only.

• Ensure all work is carried out at an anti-static workstation and that an anti-static wrist strap is worn.

• Ensure solder, wire, or foreign matter does not enter the telephone as damage may result.

• Use only approved components as specified in the parts list.

• Ensure all components, modules, screws and insulators are correctly re-fitted after servicing and
alignment.

• Ensure all cables and wires are repositioned correctly.

• Never test a mobile phone WCDMA transmitter with full Tx power, if there is no possibility to perform the
measurements in a good performance RF-shielded room. Even low power WCDMA transmitters may disturb
nearby WCDMA networks and cause problems to 3G cellular phone communication in a wide area.

• During testing never activate the GSM or WCDMA transmitter without a proper antenna load, otherwise
GSM or WCDMA PA may be damaged.
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ESD protection
Nokia requires that service points have sufficient ESD protection (against static electricity) when servicing
the phone.

Any product of which the covers are removed must be handled with ESD protection. The SIM card can be
replaced without ESD protection if the product is otherwise ready for use.

To replace the covers ESD protection must be applied.

All electronic parts of the product are susceptible to ESD. Resistors, too, can be damaged by static electricity
discharge.

All ESD sensitive parts must be packed in metallized protective bags during shipping and handling outside
any ESD Protected Area (EPA).

Every repair action involving opening the product or handling the product components must be done under
ESD protection.

ESD protected spare part packages MUST NOT be opened/closed out of an ESD Protected Area.

For more information and local requirements about ESD protection and ESD Protected Area, contact your local
Nokia After Market Services representative.
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Care and maintenance
This product is of superior design and craftsmanship and should be treated with care. The suggestions below
will help you to fulfil any warranty obligations and to enjoy this product for many years.

• Keep the phone and all its parts and accessories out of the reach of small children.

• Keep the phone dry. Precipitation, humidity and all types of liquids or moisture can contain minerals that
will corrode electronic circuits.

• Do not use or store the phone in dusty, dirty areas. Its moving parts can be damaged.

• Do not store the phone in hot areas. High temperatures can shorten the life of electronic devices, damage
batteries, and warp or melt certain plastics.

• Do not store the phone in cold areas. When it warms up (to its normal temperature), moisture can form
inside, which may damage electronic circuit boards.

• Do not drop, knock or shake the phone. Rough handling can break internal circuit boards.

• Do not use harsh chemicals, cleaning solvents, or strong detergents to clean the phone.

• Do not paint the phone. Paint can clog the moving parts and prevent proper operation.

• Use only the supplied or an approved replacement antenna. Unauthorised antennas, modifications or
attachments could damage the phone and may violate regulations governing radio devices.

All of the above suggestions apply equally to the product, battery, charger or any accessory.
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Company Policy
Our policy is of continuous development; details of all technical modifications will be included with service
bulletins.

While every endeavour has been made to ensure the accuracy of this document, some errors may exist. If
any errors are found by the reader, NOKIA MOBILE PHONES Business Group should be notified in writing/e-
mail.

Please state:

• Title of the Document + Issue Number/Date of publication

• Latest Amendment Number (if applicable)

• Page(s) and/or Figure(s) in error

Please send to:
NOKIA CORPORATION

Nokia Mobile Phones Business Group

Nokia Customer Care

PO Box 86

FIN-24101 SALO

Finland

E-mail: Service.Manuals@nokia.com
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Battery information
Note: A new battery's full performance is achieved only after two or three complete charge and
discharge cycles!

The battery can be charged and discharged hundreds of times but it will eventually wear out. When the
operating time (talk-time and standby time) is noticeably shorter than normal, it is time to buy a new battery.

Use only batteries approved by the phone manufacturer and recharge the battery only with the chargers
approved by the manufacturer. Unplug the charger when not in use. Do not leave the battery connected to
a charger for longer than a week, since overcharging may shorten its lifetime. If left unused a fully charged
battery will discharge itself over time.

Temperature extremes can affect the ability of your battery to charge.

For good operation times with Li-Ion batteries, discharge the battery from time to time by leaving the product
switched on until it turns itself off (or by using the battery discharge facility of any approved accessory
available for the product). Do not attempt to discharge the battery by any other means.

Use the battery only for its intended purpose.

Never use any charger or battery which is damaged.

Do not short-circuit the battery. Accidental short-circuiting can occur when a metallic object (coin, clip or
pen) causes direct connection of the + and - terminals of the battery (metal strips on the battery) for example
when you carry a spare battery in your pocket or purse. Short-circuiting the terminals may damage the battery
or the connecting object.

Leaving the battery in hot or cold places, such as in a closed car in summer or winter conditions, will reduce
the capacity and lifetime of the battery. Always try to keep the battery between 15°C and 25°C (59°F and 77°
F). A phone with a hot or cold battery may temporarily not work, even when the battery is fully charged.
Batteries' performance is particularly limited in temperatures well below freezing.

Do not dispose of batteries in a fire!

Dispose of batteries according to local regulations (e.g. recycling). Do not dispose as household waste.
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 Product selection

RM-179/223 is a WCDMA/GSM dual mode handportable phone. It supports EGSM900/1800/1900 and
WCDMA2100. RM-179 has 8GB internal memory and RM-223 a micro SD card.

RM-179/223 is a 3GPP Release 4 terminal supporting CSD/HCSD, GPRS/EGPRS and WCDMA data bearers. For
WCDMA the maximum bit rate is up to 384 kbps for downlink and 384 kbps for uplink with simultaneous CS
speech or CS video (max. 64 kbps).

For 2G and 2.5G networks the RM-179/223 is a Class B EGPRS MSC 32, which means a in maximum download
speed of up to 296kbit/s with EGPRS, and up to 107kbit/s with GPRS. According to GSM standard 05.05 it
responds to class 4 (max. 2W) in GSM 850 and EGSM 900, class 1 (1W) is DCS 1800, and class 1 in PCS 1900.

RM-179/223 supports Bluetooth 2.0 + EDR standard and two-way video calls with two integrated cameras,
on the front and one on the back. The main camera is an integrated 2 Megapixel camera with a digital zoom
and the secondary CIF camera is for video calls.

RM-179/223 is an MMS (Multimedia Messaging Service) enabled multimedia device. The MMS implementation
follows the OMA MMS standard release 1.2. It has a large 2.4’’ QVGA (320x240 pixels) TFT display with 16
million colors.

The HTML browser is a highly advanced internet browser also capable of viewing operator domain XHTML
Mobile Profile (MP) content.

RM-179/223 uses Symbian 9.x (S60) operating system and supports also MIDP Java 2.0, providing a good
platform for compelling 3rd party applications.

Figure 1 RM-179 phone Figure 2 RM-223 phone

 Product features and sales package

Hardware features
• GPRS multi slot at least class 10 (4+1, 2+2), class B
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• EGPRS multi slot at least class 10 (4+1, 2+2), class B

• DTM Support (MSC11)

• Speech codecs: FR, EFR, AMR

• Internal handsfree/music stereo speaker

• Internal vibrating alert

• 2mm charger

Display and keys
• Active matrix 2.4” QVGA main colour display (320 x 240 pixels), up to 16 million colors

• Media keys: play/pause, forward, rewind, stop

• Keys: two gaming keys, two softkeys, send & end, 5-way navigator, S60 keys (application, clear), ITU-T
keypad, volume keys (up & down), camera key, power key, lock switch, Navi™ wheel

Connectivity
• WLAN IEEE802.11 b/g with UPnP support

• Bluetooth Specification 2.0 (profiles supported: DUN, OPP, FTP, HFP, GOEP, GAP, SPP, HSP, BIP, A2DP)

• Micro USB 2.0 Full Speed (mass storage class)

• Nokia AV Connector 3.5mm

Software features
• Operating system: Symbian ver. 9.2

• User interface: S60 3rd Edition, Feature Pack (S60 3.1)

• NCP 5.0

• Java™ MIDP 2.0, CLDC 1.1

• Flash Lite 2.0

• C++ and Java SDKs

Additional technical specifications
• Protocols: MTP, UPnP, TCP/IP

Memory
• Internal flash memory (8 GB) (RM-179)

• MicroSD card (support up to 32GB, hotswap) (RM-223)

Sales package
• Transceiver RM-179/223

• 3.5mm Stereo Headset with Remote Control (HS-45 + AD-54)

• MicroSD card (1GB) (MU-22) (only RM-223)

• Micro USB Data Cable (CA-101)

• Battery (BP-6MT)

• Travel Charger (AC-5)

• CD ROM

• User Guide

• Quick Guide

RM-179; RM-223
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• Sales carton

 Mobile enhancements

Data

Enhancement Type

Charging connectivity cable CA-100

Micro-USB connect cable CA-101

MicroSD card MU-27 (256 MB)

MU-28 (512 MB)

MU-22 (1 GB)

MU-37 (2 GB)

MU-41 (4 GB)

Power

Enhancement Type

Battery 1050 mAh BP-6MT

Travel charger AC-4

AC-5

Mobile charger DC-4

Baby feeder, large battery to charge phone battery
3 -5 times

DC-1

First aid charger DC-8

Retractable mobile charger DC-9

Charger adapter CA-44

Audio

Enhancement Type

Stereo headset HS-43

HS-48

Music headset HS-16

AD-43

Headset HS-41

3.5 mm headphone HS-44

HS-45

HS-61

HS-62
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Enhancement Type

Bluetooth headset BH-200

BH-300

BH-600

BH-301

BH-302

BH-801

BH-202

BH-700

BH-800

BH-900

HS-26W

BH-201

BH-207

BH-701

BH-902

BH-100

BH-303

BH-208

BH-602

Bluetooth stereo headset HS-12W

BH-601

BH-500

BH-501

TTY adapter HDA-12

Messaging

Enhancement Type

Wireless keyboard SU-8W

Digital pen SU-27W

Music

Enhancement Type

Music headphones HS-61

Advanced music headphones HS-62

Mini speaker MD-4

RM-179; RM-223
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Enhancement Type

Music speaker MD-3

Bluetooth speaker MD-5W

Positioning

Enhancement Type

Wireless GPS module LD-3W

Car

Enhancement Type

Wireless plug-in car handsfree HF-6W

HF-33W

HF-34W

HF-35W

Advanced car kit CK-7W

CK-15W

CK-20W

CK-25W

Car kit Nokia 616

Universal holder CR-82

 Technical specifications

Transceiver general specifications

Unit Dimensions (L x W x T) (mm) Weight (g) Volume (cm3)

Transceiver with BP-6MT
1050 mAh li-ion battery

102 x 50 x 17.9 ~140 88

Main RF characteristics for GSM850/EGSM900/GSM1800/GSM1900 and WCDMA phones

Parameter Unit

Cellular system GSM850, EGSM900, GSM1800/1900, or WCDMA2100

Rx frequency band GSM850: 869 - 894MHz

EGSM900: 925 - 960 MHz

GSM1800: 1805 - 1880 MHz

GSM1900: 1930 - 1990 MHz

WCDMA2100: 2110 - 2170 MHz

RM-179; RM-223
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Parameter Unit

Tx frequency band GSM850: 824 - 849MHz

EGSM900: 880 - 915 MHz

GSM1800: 1710 - 1785 MHz

GSM1900: 1850 - 1910 MHz

WCDMA2100: 1920 - 1980 MHz

Output power GSM850: +5 ...+33dBm/3.2mW ... 2W

GSM900: +5 … +33dBm/3.2mW … 2W

GSM1800: +0 … +30dBm/1.0mW … 1W

GSM1900: +0 … +30dBm/1.0mW … 1W

WCDMA -50 … 24 dBm

Number of RF channels GSM850: 125

GSM900: 175

GSM1800: 375

GSM1900: 299

Channel spacing 200 kHz

Number of Tx power levels GSM850: 15

GSM900: 15

GSM1800: 16

GSM1900: 16

Battery endurance

Battery Talk time Stand-by Video call
time

Music playback
time

BP-6MT 1050 mAh 4.3h (GSM@29dBm)

3h (WCDMA@10dBm)

17days (GSM)

20days (WCDMA)

2.1h 10h

Note: Operation times may vary depending on radio access technology used, operator network
configuration and usage.

Charging times

AC-5

1h20min
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 Service tools

Product specific tools
The table below gives a short overview of service tools that can be used for testing, error analysis and repair
of product RM-179; RM-223, refer to various concepts.

FS-37 Flash adapter

FS-37 is a product specific adapter for SW update and testing purposes.
It is compatible to SS-62 and SS-46. It provides galvanic connetion to
terminal test pads and battery connector.
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MJ-114 Module jig

The module jig offers engine module component level repair, analysis
and alignment capabilities in combination with CU-4.

Features:

• connection interfaces for GSM, WCDMA, Bluetooth and WLAN
antenna

• galvanic connection to engine module test pads

• multiplexing between USB an FBUS media, controlled by VUSB with
CU-4

• lid interconnection with test points for measurements

• connection to lid assembly incl. displays and earpiece

• connector for e.g. CU-4 control unit

• connection for BT / SIM / SD-card module

Note: There is one RF connection for GSM and WCDMA 2100
Tx (transmitter path) and one RF connection for WCDMA 2100
Rx (receiver path).

• Table 1 MJ-114 attenuation table

Band (mid.
ch.)

Channel Frequency
/MHz

Attenuation
Loss / dB

850 TX 189 836,6 0,32

850 RX 189 881,6 0,3

900 TX 37 897,4 0,27

900 RX 37 942,4 0,32

1800 TX 700 1747,8 0,33

1800 RX 700 1842,8 0,4

1900 TX 661 1880 0,35

1900 RX 661 1910 0,4

WCDMA TX 9750 1950 0,4

WCDMA RX 10700 2140 0,4

RJ-130 Soldering jig

RJ-130 is a jig to support component level exchange with soldering
machines for the engine module.
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SA-113 RF coupler

SA-113 is an RF coupler for WCDMA and GSM RF testing. It is used
together with the product-specific flash adapter.

For the attenuation values, see SA-113 attenuation values
(page 2–7).

SA-113 attenuation values
The following table shows attenuations from the antenna pads of the mobile terminal to the SMA connectors
of SA-113:

Slider OPEN Slider CLOSE

Band Channel
UP/

DOWN

TX f [MHz] RX f [MHz] TX Loss
[dB]

RX Loss
[dB]

TX Loss
[dB]

RX Loss
[dB]

GSM 850

Low 128 824.2 869.2 7.34 13.16 6.84 13.33

Mid 189 836.4 881.4 6.47 12.07 5.90 12.04

High 251 858.8 893.8 5.94 10.65 5.26 10.05

GSM 900

Low 975 880.2 925.2 11.76 6.45 10.52 5.44

Mid 37 897.4 942.8 10.56 6.12 8.63 4.79

High 124 915.8 960.8 4.31 6.48 4.13 4.93

GSM 1800

Low 512 1710.2 1805.2 11.82 19.03 10.61 18.03

Mid 698 1747.4 1842.4 11.68 16.89 10.79 15.33

High 885 1784.8 1879.8 12.24 14.88 11.19 13.16

GSM 1900

Low 512 1850.2 1930.2 12.15 12.06 11.05 11.32

Mid 661 1880.0 1960.0 11.85 12.79 10.95 11.76

High 810 1909.8 1989.8 11.93 13.20 11.35 11.89

WCDMA I

Low
9613 /
10563 1922.4 2112.4 17.60 16.82 17.47 15.21

Mid
9750 /
10700 1950.0 2140.0 17.80 15.61 17.24 14.54

High
9887 /
10837 1977.6 2167.6 17.82 15.77 17.19 15.20
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General tools
The table below gives a short overview of service tools that can be used for testing, error analysis and repair
of product RM-179; RM-223, refer to various concepts.
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CU-4 Control unit

CU-4 is a general service tool used with a module jig and/or a flash
adapter. It requires an external 12 V power supply.

The unit has the following features:

• software controlled via USB

• EM calibration function

• Forwards FBUS/Flashbus traffic to/from terminal

• Forwards USB traffic to/from terminal

• software controlled BSI values

• regulated VBATT voltage

• 2 x USB2.0 connector (Hub)

• FBUS and USB connections supported

When using CU-4, note the special order of connecting cables and
other service equipment:

Instructions
1 Connect a service tool (jig, flash adapter) to CU-4.

2 Connect CU-4 to your PC with a USB cable.

3 Connect supply voltage (12 V)

4 Connect an FBUS cable (if necessary).

5 Start Phoenix service software.

Note: Phoenix enables CU-4 regulators via USB when it is
started.

Reconnecting the power supply requires a Phoenix restart.
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FLS-5 Flash device

FLS-5 is a dongle and flash device incorporated into one package,
developed specifically for POS use.

Note: FLS-5 can be used as an alternative to PKD-1.

FPS-10 Flash prommer

FPS-10 interfaces with:

• PC

• Control unit

• Flash adapter

• Smart card

FPS-10 flash prommer features:

• Flash functionality for BB5 and DCT-4 terminals

• Smart Card reader for SX-2 or SX-4

• USB traffic forwarding

• USB to FBUS/Flashbus conversion

• LAN to FBUS/Flashbus and USB conversion

• Vusb output switchable by PC command

FPS-10 sales package includes:

• FPS-10 prommer

• Power Supply with 5 country specific cords

• USB cable

Note: FPS-21 is substitute FPS-10 if FPS-10 has not been set
up.

JXS-1 RF shield box

Because the WCDMA network disturbs the RX side testing of the WCDMA
phone and the Tx signal of the WCDMA phone can severely disturb the
WCDMA network, a shield box is needed in all testing, tuning and fault
finding which requires WCDMA RF signal.

The shield box is not an active device, it contains only passive filtering
components for RF attenuation.
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PK-1 Software protection
key

PK-1 is a hardware protection key with a USB interface. It has the same
functionality as the PKD-1 series dongle.

PK-1 is meant for use with a PC that does not have a series interface.

To use this USB dongle for security service functions please register
the dongle in the same way as the PKD-1 series dongle.

PKD-1 SW security device

SW security device is a piece of hardware enabling the use of the
service software when connected to the parallel (LPT) port of the PC.

Without the device, it is not possible to use the service software.

Printer or any such device can be connected to the PC through the
device if needed.

RJ-104 Rework jig

RJ-104 is a rework jig used when servicing the BTHFM (D6000) module.
It is used together with rework stencil ST-37.

RJ-157 Rework jig

RJ-157 is a jig used for soldering and as a rework jig for the engine
module. It is used together with the ST-55 stencil.
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RJ-160 Rework jig

RJ-160 is a jig used for soldering and as a rework jig for the engine
module. It is used together with the ST-55 stencil.

RJ-169 Rework jig

RJ-169 is a jig used for soldering and as a rework jig for the engine
module. It is used together with the ST-59 stencil.

RJ-93 Rework jig

RJ-93 is used as a rework jig for the Front End Module (FEM).

This rework jig takes the FEM or power amplifier (PA) module (N7520)
for spreading the soldering paste to the component. Must be used
together with the ST-40 stencil.

SB-6 Bluetooth test and
interface box (sales
package)

The SB-6 test box is a generic service device used to perform Bluetooth
bit error rate (BER) testing, and establishing cordless FBUS connection
via Bluetooth. An ACP-8x charger is needed for BER testing and an
AXS-4 cable in case of cordless interface usage testing .

Sales package includes:

• SB-6 test box

• Installation and warranty information
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SPS-1 Soldering Paste
Spreader

The SPS-1 allows spreading of solder to the LGA components pads over
the rework stencils.

SRT-6 Opening tool

SRT-6 is used to open phone covers.

SS-46 Interface adapter

SS-46 acts as an interface adapter between the flash adapter and
FPS-10.

SS-62 Generic flash adapter
base for BB5

• generic base for flash adapters and couplers

• SS-62 equipped with a clip interlock system

• provides standardised interface towards Control Unit

• provides RF connection using galvanic connector or coupler

• multiplexing between USB and FBUS media, controlled by VUSB
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ST-37 BTHFM rework stencil

ST-37 stencil is used with the RJ-104 rework jig to service the BTHFM
(D6000) module.

ST-40 Rework stencil

ST-40 is a rework stencil that is used with the RJ-93 rework jig to
service the Front End Module (N7520).

ST-55 Rework stencil

ST-55 is a rework stencil used with rework jig RJ-157 and RJ-160.

ST-59 Rework stencil

ST-59 is a rework stencil used with rework jig RJ-169.

SX-4 Smart card

SX-4 is a BB5 security device used to protect critical features in tuning
and testing.

SX-4 is also needed together with FPS-10 when DCT-4 phones are
flashed.

Cables
The table below gives a short overview of service tools that can be used for testing, error analysis and repair
of product RM-179; RM-223, refer to various concepts.
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CA-101 Micro USB cable

The CA-101 is a USB-to-microUSB data cable that allows connections
between the PC and the phone.

CA-35S Power cable

CA-35S is a power cable for connecting, for example, the FPS-10 flash
prommer to the Point-Of-Sales (POS) flash adapter.

CA-58RS RF tuning cable

RF tuning cable for use with a flash adapter.

CA-58RS RF cable extends adapter features to allow RF function tests
and RF tuning in GSM bands.

Features include:

• easy to use together with flash adapter or even stand alone

• most accurate RF connection to phone module under test

• most accurate RF connection to phone module under test

• low attenuation and small “ripple” over the width of each GSM band

Note: The RF cable must be used for RF tuning.
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DAU-9S MBUS cable

The MBUS cable DAU-9S has a modular connector and is used, for
example, between the PC's serial port and module jigs, flash adapters
or docking station adapters.

Note: Docking station adapters valid for DCT4 products.

PCS-1 Power cable

The PCS-1 power cable (DC) is used with a docking station, a module
jig or a control unit to supply a controlled voltage.

XCS-4 Modular cable

XCS-4 is a shielded (one specially shielded conductor) modular cable
for flashing and service purposes.

XRF-1 RF cable

The RF cable is used to connect, for example, a module repair jig to
the RF measurement equipment.

SMA to N-Connector ca. 610mm.

Attenuation for:

• GSM850/900: 0.3+-0.1 dB

• GSM1800/1900: 0.5+-0.1 dB

• WLAN: 0.6+-0.1dB
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 Service concepts

POS (Point of Sale) flash concept

Figure 3 POS flash concept

Type Description

Product specific tools

BP-6MT Battery

Other tools

FLS-5 POS flash dongle

PC with Phoenix service software

Cables

DKE-2 USB connectivity cable

RM-179; RM-223
Service Tools and Service Concepts

Issue 1 COMPANY CONFIDENTIAL Page 2 –17
Copyright © 2007 Nokia. All rights reserved.



Flash concept with FPS-10

Figure 4 Basic flash concept with FPS-10

Type Description

Product specific devices

FS-37 Flash adapter

Other devices

FPS-10 Flash prommer box

PKD-1/PK-1 SW security device

SS-46 Interface adapter

PC with Phoenix service software

Cables

XCS-4 Modular cable

CA-35S Power cable

USB cable
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Flash concept with FLS-5 and SS-46

Figure 5 Flash concept with FLS-5 and SS-46

Type Description

Product specific tools

FS-37 Flash adapter

Other tools

FLS-5 POS flash dongle

SS-46 Interface adapter

PC with Phoenix service software

Cables

CA-89DS Cable
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CU-4 flash concept with FPS-10

Figure 6 CU-4 flash concept with FPS-10

Type Description

Product specific devices

FS-37 Flash adapter

Other devices

CU-4 Control unit

FPS-10 Flash prommer box

PKD-1/PK-1 SW security device

SS-62 Flash adapter base

SX-4 Smart card

PC with Phoenix service software

Cables

PCS-1 Power cable

XCS-4 Modular cable

Standard USB cable

USB cable
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Flash concept with FLS-5 and SS-62

Figure 7 Basic flash concept with FLS-5 and SS-62

Type Description

Product specific tools

FS-37 Flash adapter

Other tools

CU-4 Control unit

FLS-5 POS flash dongle

SS-62 Flash adapter base

PC with Phoenix service software

Cables

CA-89DS Cable

PCS-1 Power cable

Standard USB cable

USB cable
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Flash concept with FLS-5 and module jig

Figure 8 Flash concept with FLS-5 and module jig

Type Description

Product specific tools

MJ-114 Module jig

Other tools

CU-4 Control unit

FLS-5 POS flash dongle

PC with Phoenix service software

Cables

CA-89DS Cable

PCS-1 DC power cable

USB cable
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Module jig service concept

Figure 9 Module jig service concept

Type Description

Phone specific devices

MJ-114 Module jig

Other devices

CU-4 Control unit

FPS-10 Flash prommer box

PKD-1/PK-1 SW security device

SX-4 Smart card

PC with VPOS and Phoenix service software

Measurement equipment

Cables

PCS-1 DC power cable

XCS-4 Modular cable

XRF-1 RF cable

USB cable

RM-179; RM-223
Service Tools and Service Concepts

Issue 1 COMPANY CONFIDENTIAL Page 2 –23
Copyright © 2007 Nokia. All rights reserved.



Type Description

GPIB control cable

Service concept for RF testing and RF/BB tuning

Figure 10 Service concept for RF testing and RF/BB tuning

Type Description

Product specific devices

MJ-114 Module jig

Other devices

CU-4 Control unit

PKD-1/PK-1 SW security device

SX-4 Smart card

Measurement equipment

Smart card reader

PC with Phoenix service software

Cables

DAU-9S MBUS cable

PCS-1 DC power cable
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Type Description

XRS-6 RF cable

GPIB control cable

USB cable

RF testing / BB tuning concept

Figure 11 RF testing / BB tuning concept

Type Description

Product specific tools

FS-37 Flash adapter

SA-113 RF coupler

Other tools

CU-4 Control unit

PKD-1/PK-1 SW security device

SS-62 Flash adapter base

SX-4 Smart card

Measurement equipment

Smart card reader

PC with Phoenix service software
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Type Description

Cables

DAU-9s MBUS cable

PCS-1 DC power cable

XRS-6 RF cable

USB cable

RF/BB tuning and flashing with FPS-10

Figure 12 RF/BB tuning and flashing with FPS-10

Type Description

Product specific tools

MJ-114 Module jig

Other tools

CU-4 Control unit

FPS-10 Flash prommer box

PKD-1/PK-1 SW security device

SX-4 Smart card

Measurement equipment

PC with Phoenix service software
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Type Description

Cables

PCS-1 DC power cable

XCS-4 Modular cable

XRS-6 RF cable

USB cable

RF/BB tuning and flashing with FLS-5

Figure 13 RF/BB tuning and flashing with FLS-5

Type Description

Product specific tools

MJ-114 Module jig

Other tools

CU-4 Control unit

FLS-5 POS flash dongle

PKD-1/PK-1 SW security device

SX-4 Smart card

Measurement equipment

PC with Phoenix service software
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Type Description

Smart card reader

Cables

CA-89DS Cable

PCS-1 DC power cable

XRS-6 RF cable

USB cable

Bluetooth test concept with SB-6

Figure 14 Bluetooth test concept with SB-6

Type Description

Product specific tools

FS-37 Flash adapter

Other tools

CU-4 Control unit

PKD-1 SW Security device

SS-62 Generic base adapter

SB-6 BT test box

ACP-8 Charger for SB-6

Cables

PCS-1 Power cable

DAU-9S Cable
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Type Description

PCS-1 DC power cable

Standard USB cable
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 Troubleshooting overview
For practical reasons, troubleshooting is divided into two sections;

• Baseband troubleshooting, including camera, FM radio and Bluetooth.

• RF troubleshooting
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 Dead or jammed device troubleshooting

Troubleshooting flow
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 General power checking
Check the following voltages:

Signal
name

Regulator Sleep Idle Nominal
voltage

Main user Notes Supply

VIO External
SMPS
N2201

ON ON 1.82 Displays, I/Os

VBACK AVILMA ON ON 2.6 Back-up battery

VSIM1

VSIM2 AVILMA ON ON VBAT3

VDRAM External
SMPS
N2201

ON ON 1.82 SDRAM

VAUX AVILMA OFF OFF 2.78 FM radio, ALS, MR
sensor, displays

VBAT5

VANA AVILMA ON ON 2.5 AVILMA VBAT4

VR1 AVILMA OFF ON 2.5 Crystal oscillators VBAT4

VRFC AVILMA ON OFF 1.8 RAPIDO converters

VRCP1 AVILMA 4.75 To RF parts RF active VBATCP

VRCP2 AVILMA 4.75 VBATCP

VREF AVILMA ON ON 1.35 RF reference

VCORE External
SMPS
N2390

ON ON 1.35/1.05
on sleep

RAPIDO digital
core

VOUT BETTY OFF OFF 2.5 Audio switch

VCAMANA External
LDO N2501

2.8 Camera

VCAMDIG External
SMPS
N2500

1.8 Camera, STV984

LEDOUT External
SMPS
N2301

< 18 Display backlight According
to
Regulator
spec

VSD SD
levelshifter

2.9 MicroSD card

VIO_VILMA AVILMA ON ON 1.82 Audio, BT
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 Clocking troubleshooting

Troubleshooting flow
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 Charging troubleshooting

Troubleshooting flow
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 Backup battery troubleshooting
Verify that the backup battery is empty (U<1V). Switch the phone on. Measure voltage of the battery when
the main battery is connected to the phone and the phone is switched on.

Wait a few minutes and monitor that the backup battery voltage rises. Switch off the phone, disconnect the
main battery and monitor that the voltage of the backup battery decreases. Normal behaviour of the voltage
is described in the figures below.

Figure 15 Charging backup battery

Figure 16 Discharging backup battery

If the voltage rises and falls quickly, check whether either G2200 or C2233 is broken or short-circuited. Backup
battery can be also dead. If the voltage stays ~0V, check resistance VBACK against GND. If there is no short
circuit, AVILMA is faulty. Replace AVILMA.
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 Flash programming fault troubleshooting

Part 1
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Part 2

Figure 17 Take single trig measurement for the rise of the BSI signal.
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 Combo memory troubleshooting

Troubleshooting flow
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 MicroSD card troubleshooting

Troubleshooting flow

RM-179; RM-223
Baseband Troubleshooting

Page 3 –14 COMPANY CONFIDENTIAL Issue 1
Copyright © 2007 Nokia. All rights reserved.



RM-179; RM-223
Baseband Troubleshooting

Issue 1 COMPANY CONFIDENTIAL Page 3 –15
Copyright © 2007 Nokia. All rights reserved.



 EMMC troubleshooting

Troubleshooting flow
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Figure 18 EMMC initialise
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 USB interface troubleshooting

Troubleshooting flow
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Figure 19 USB connector
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 SIM card troubleshooting

Troubleshooting flow
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 Hall sensor troubleshooting

Troubleshooting flow
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 WLAN interface troubleshooting

Troubleshooting flow
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Figure 20 WLAN alignment targets

 Keyboard troubleshooting

Context
There are two possible failure modes in the keyboard module:

• One or more keys can be stuck, so that the key does not react when a keydome is pressed. This kind of
failure is caused by mechanical reasons (dirt, rust).

• Malfunction of several keys at the same time; this happens when one or more rows or columns are failing
(shortcut or open connection). For a more detailed description of the keyboard and keymatrix, see section
Keyboard.

If the failure mode is not clear, start with the Keyboard Test in Phoenix.
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Troubleshooting flow
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 NaviWheel troubleshooting

Troubleshooting flow
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 Power key troubleshooting

Troubleshooting flow
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 Vibra troubleshooting

Troubleshooting flow

RM-179; RM-223
Baseband Troubleshooting

Page 3 –28 COMPANY CONFIDENTIAL Issue 1
Copyright © 2007 Nokia. All rights reserved.



 Display module troubleshooting

General instructions for display troubleshooting

Context
• The display is in a normal mode when the phone is in active use.

• The display is off when the phone is in the screen saver mode. Then power LED is active.

• The operating modes of the display can be controlled with the help of Phoenix.

Table 2 Display module troubleshooting cases

Display blank There is no image on the display. The display looks
the same when the phone is on as it does when the
phone is off. The backlight can be on in some cases.

Image on the display not correct Image on the display can be corrupted or a part of
the image can be missing. If a part of the image is
missing, change the display module. If the image is
otherwise corrupted, follow the appropriate
troubleshooting diagram.

Backlight dim or not working at all Backlight LED components are inside the display
module. Backlight failure cause can also be in the
display connector, 70pol engine connector, the
SliderFlex or in the backlight power source in the
main engine of the phone.

This means that in case the display is working
(image OK), the backlight is faulty.

Visual defects (pixel) Pixel defects can be checked by controlling the
display with Phoenix. Use both colours, black and
white, on a full screen.

The display may have some random pixel defects
that are acceptable for this type of display. The
criteria when pixel defects are regarded as a display
failure, resulting in a replacement of the display, are
presented the following table.

Table 3 Pixel defects

Item White dot defect Black dot
defect

Total

1 Defect counts R G B White Dot
Total

1 1

1 1 1 1

2 Combined
defect counts

Not allowed.

Two single dot defects that are within 5 mm of each other should be
interpreted as combined dot defect.
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Steps
1. Verify with a working SlideModule that the fault is not the SliderFlex.

2. Verify with a working display that the fault is not on the display module itself.

The display module cannot be repaired.

3. Check that the cellular engine is working normally.

i To check the functionality, connect the phone to a docking station.

ii StartPhoenix service software.

iii Read the phone information to check that also the application engine is functioning normally (you
should be able to read the APE ID).

4. Proceed to the display troubleshooting flowcharts.

Use the Display Test tool in Phoenix to find the detailed fault mode.

Display troubleshooting

Context
Before going to display troubleshooting flow, make sure that the engine is working and starting up correctly.
If the problem is in the engine, go to baseband troubleshooting.
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Troubleshooting flow
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LED driver troubleshooting

Context
The phone has three illumination drivers. One of them provides the LED current for the display, the menu
keys and the gaming keys. One other provides the LED current for ITU-keyboard and side keys.

The third one provides the FlashLED current. For instructions for troubleshooting this driver, see Flash LED
troubleshooting (page 5–13).
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LED driver troubleshooting part 1
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LED driver troubleshooting part 2
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Power LED troubleshooting

Troubleshooting flow
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 Bluetooth and FM radio

Introduction to Bluetooth/FM Radio troubleshooting
Bluetooth problems that can occur:

Problem Description

A malfunction in the BT ASIC, BB ASICs or
Phone’s BT SMD components.

This could have many causes i.e. SW or HW related.

No BT link can be established. • Bad contact of c-clips (X6302, X6300) to the corresponding
antenna pads.

• Damaged component or bad contact of R6420 (0 Ohm), BT/
WLAN frontend (N6301) or ISM band filter (Z6300).

Bluetooth/FM Radio component layout

Figure 21 Bluetooth and FM radio component layout

Bluetooth settings for Phoenix

Steps
1. Start Phoenix service software.

2. From the File menu, choose Open Product, and then choose the correct type designator from the
Product list.

3. Place the phone to a flash adapter in the local mode.

4. Choose Testing→Bluetooth LOCALS .

5. Locate JBT-9’s serial number (12 digits) found in the type label on the back of JBT-9.

In addition to JBT-9, also SB-6, JBT-3 and JBT-6 Bluetooth test boxes can be used.

6. In the Bluetooth LOCALS window, write the 12-digit serial number on the
Counterpart BT Device Address line.

This needs to be done only once provided that JBT-9 is not changed.

7. Place the JBT-9 box near (within 10 cm) the BT antenna and click Run BER Test.

Results
Bit Error Rate test result is displayed in the Bit Error Rate (BER) Tests pane in the Bluetooth LOCALS window.
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Figure 22 BER test result

Bluetooth self tests in Phoenix

Steps
1. Start Phoenix service software.

2. ChooseFile→Scan Product.

3. Place the phone to a flash adapter.

4. From the Mode drop-down menu, set mode to Local.

5. Choose Testing→Self Tests.

6. In the Self Tests window check the following Bluetooth related tests:

• ST_LPRF_IF_TEST

• ST_LPRF_AUDIO_LINES_TEST

• ST_BT_WAKEUP_TEST
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7. To run the tests, click Start.

Figure 23 Bluetooth self tests in Phoenix
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Bluetooth troubleshooting

Troubleshooting flow
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FM radio troubleshooting

Troubleshooting flow

 Audio troubleshooting

Audio troubleshooting test instructions
Single ended external earpiece and differential internal earpiece/IHF outputs can be measured either with a
single ended or a differential probe.

When measuring single ended, each output is measured against ground.

Note: Do not connect ground of single ended probe to 2nd signal of differential lines.

Internal handsfree output is measured using a current probe, if a special low-pass filter designed for
measuring a digital amplifier is not available. Note also, that when using a current probe, input signal
frequency must be set to 2kHz.

The signal for input is single ended.

Required equipment
The following equipment is needed for the tests:
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• Oscilloscope
• Function generator (sine waveform)
• Current probe (Internal handsfree PWM output measurement)
• Phoenix service software
• Power supply 3.7V

Test procedure
Ausio can be tested using Phoenix audio routings option. Four different audio loop paths can be activated:

• External mic to external earpiece
• External mic to internal earpiece
• External mic to internal handsfree speaker (IHF, mono signal to both speakers)
• Internal mic to external earpiece

Each audio loop sets routing from the specified input to the specified output enabling a quick in-out test.
Loop path gains are fixed an can not be changed using phoenix. Correct pins an signals for each test see
following table.

Phoenix audio loop tests and test results
The results presented in the table apply, when no accessory is connected. Earpiece, internal mic and speaker
are in place during measurement. Applying a headset accessory during measurement causes a significant
drop in measured levels.

The gain values presented in table apply for differential output vs single ended input.

Loop test Input
terminal

Output
terminal

Path gain
[dB] fixed

Input
Voltage
[mVpp]

Differenti
al

outputvol
tage

[mVpp]

Output DC
level [V]

Output
current

Ext Mic ->
Ext Earp

HS-MIC &
GND

HSEARL&G
ND

-8.6 1000 367 1,2

HSEARR&
GND

Ext Mic ->
Int Earp

HS-MIC &
GND

EarP &
GND

-10 1000 310 1,2

EarN &
GND

Ext Mic ->
Int Hands
Free

XMICP &
GND

B2150
B2151 all
terminals

8,5 920 2520 0 ~25mA
each

XMICN &
GND

Int Mic ->
Int Hands
Free

Acoustica
l input,
1khz sine
wave

IHF
Speakerp
ad

94 dB SPL -

Measurement data
Earpiece signal
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Figure 24 Single-ended output waveform of the Ext_in_HP_out measurement when earpiece is connected.

Integrated handsfree signal

Figure 25 Differential output waveform of the Ext_in_IHF_out out loop measurement when speaker is connected.

External output from AV

Figure 26 Single-ended output waveform of the Ext_in_Ext_out loop.

RM-179; RM-223
Baseband Troubleshooting

Issue 1 COMPANY CONFIDENTIAL Page 3 –43
Copyright © 2007 Nokia. All rights reserved.



External output from AV (acoustic input)

Figure 27 Single-ended output waveform of the HP_in_Ext_out loop.
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Internal earpiece troubleshooting

Troubleshooting flow
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Internal microphone troubleshooting

Troubleshooting flow
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IHF speakers troubleshooting

Troubleshooting flow
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External microphone troubleshooting

Troubleshooting flow
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External earpiece troubleshooting

Troubleshooting flow
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Acoustics troubleshooting

Introduction to acoustics troubleshooting
Acoustics design ensures that the sound is detected correctly with a microphone and properly radiated to
the outside of the device by speaker(s). The acoustics of the phone includes three basic systems: earpiece,
Integrated Hands Free (IHF) and microphone.

The sound reproduced from the earpiece readiates through a single hole on the front cover (A-cover). The
sound reproduced from the IHF speakers radiates from left and right sound holes located on both sides of
the device. Microphone is located at the bottom, next to the system connector.

For a correct functionality of the phone, all sound holes must be always open. When the phone is used, care
must be taken not to close any of those holes with a hand or fingers. The phone should be dry and clean,
and no objects must be located in such a way that they close any of the holes.
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Earpiece troubleshooting

Troubleshooting flow
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IHF troubleshooting

Troubleshooting flow

RM-179; RM-223
Baseband Troubleshooting

Page 3 –52 COMPANY CONFIDENTIAL Issue 1
Copyright © 2007 Nokia. All rights reserved.



Microphone troubleshooting

Troubleshooting flow
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 Baseband manual tuning guide

Certificate restoring for BB5 products

Context
This procedure is performed when the device certificate is corrupted for some reason.

All tunings (RF & Baseband, UI) must be done after performing the certificate restoring procedure.

The procedure for certificate restoring is the following:

• Flash the phone with the latest available software using FPS-10 or FPS-20.

Note: USB flashing does not work for a dead BB5 phone.

• Create a request file.

• Send the file to Nokia by e-mail. Use the following addresses depending on your location:

• APAC: sydney.service@nokia.com

• CHINA: repair.ams@nokia.com

• E&A: salo.repair@nokia.com

• AMERICAS: fls1.usa@nokia.com

• When you receive a reply from Nokia, carry out certificate restoring.

• Tune the phone completely.

Note: SX-4 smart card is needed.

• If the phone resets after certificate restoring, reflash the phone again.

Required equipment and setup:

• Phoenix service software V2006.44.6.163 or newer

• The latest phone model specific Phoenix data package

• PK-1 dongle

• SX-4 smart card (Enables BB5 testing and tuning features)

Note: FPS-10 has an integrated smart card reader.

• Activated e.g FPS-10 flash prommer

• Flash update package V07.04.013 or newer for FPS-10 flash prommer

• CU-4 control unit

• USB cable from PC USB Port to CU-4 control unit

• Phone model specific adapter for CU-4 control unit

• PCS-1 cable to power CU-4 from external power supply

• XCS-4 modular cable between flash prommer and CU-4

Note: CU-4 must be supplied with +12 V from an external power supply in all steps of certificate
restoring.

Steps
1. Program the phone software.

i Start Phoenix and login. Make sure the connection has been managed correctly for FPS-10.

ii Update the phone MCU software to the latest available version.

If the new flash is empty and the phone cannot communicate with Phoenix, reflash the phone.
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iii Choose the product manually from File→Open Product , and click OK.

Wait for the phone type designator (e.g. “RM-1” ) to be displayed in the status bar.

iv Go to Flashing→Firmware Update  and wait until Phoenix reads the product data as shown in the
following picture.

Different flash files can be selected by Flashing→Firmware Update→Options  as show in the
screenshot below.
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v To continue, click Start.

Progress bars and messages on the screen show actions during phone programming, please wait.
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Programming is completed when Flashing Completed message is displayed.

The product type designator and MCU SW version are displayed in the status bar.

vi Close the Firmware Update window and then choose File→Close Product .

2. Create a Request file.

For this procedure, you must supply +12 V to CU-4 from an external power supply.

i To connect the phone with Phoenix, choose File→Scan Product .

ii Choose Tools→Certificate Restore .
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iii To choose a location for the request file, click Browse.

iv Name the file so that you can easily identify it, and click Open.

The name of the file and its location are shown.

v To create the Request file, click Start.

vi When the file for certificate restore has been created, send it to Nokia as an e-mail attachment.

3. Restore certificate.

For this procedure, you must supply +12 V to CU-4 from an external power supply.

i Save the reply file sent by Nokia to your computer.

ii Start Phoenix service software.

iii Choose File→Scan Product .
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iv From the Tools menu, choose Certificate Restore and select Process a response file in the Action
pane.

v To choose the location where response file is saved, click Browse.

vi Click Open.

The name of the file and the path where it is located are shown.

vii To write the file to phone, click Start.

Next actions
After a successful rewrite, you must retune the phone completely by using Phoenix tuning functions.

Important: Perform all tunings: RF, BB, and UI.
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Energy management calibration

Prerequisites
Energy Management (EM) calibration is performed to calibrate the setting (gain and offset) of AD converters
in several channels (that is, battery voltage, BSI, battery current) to get an accurate AD conversion result.

Hardware setup:

• An external power supply is needed.

• Supply 12V DC from an external power supply to CU-4 to power up the phone.

• The phone must be connected to a CU-4 control unit with a product-specific flash adapter.

Steps
1. Place the phone to the docking station adapter (CU-4 is connected to the adapter).

2. Start Phoenix service software.

3. Choose File→ Scan Product.

4. Choose Tuning→Energy Management.

5. To show the current values in the phone memory, click Read, and check that communication between
the phone and CU-4 works.

6. Check that the CU-4 used check box is checked.

7. Select the item(s) to be calibrated.

Note: ADC calibration has to be performed before other item(s). However, if all calibrations are
selected at the same time, there is no need to perform the ADC calibration first.

8. Click Calibrate.

The calibration of the selected item(s) is carried out automatically.

The candidates for the new calibration values are shown in the Calculated values column. If the new
calibration values seem to be acceptable (please refer to the following "Calibration value limits" table),
click Write to store the new calibration values to the phone permanent memory.

Table 4 Calibration value limits

Parameter Min. Max.

ADC Offset -20 20

ADC Gain 12000 14000

BSI Gain 1100 1300

VBAT Offset 2400 2650

VBAT Gain 19000 23000

VCHAR Gain N/A N/A

IBAT (ICal) Gain 7750 12250

9. Click Read, and confirm that the new calibration values are stored in the phone memory correctly. If the
values are not stored to the phone memory, click Write and/or repeat the procedure again.

10. To end the procedure, close the Energy Management Calibration window.
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 General RF troubleshooting

Introduction to RF troubleshooting

Most RF semiconductors are static discharge sensitive
ESD protection must be applied during repair (ground straps and ESD soldering irons).

Pre-baking
These parts are moisture sensitive and must be pre-baked prior to soldering:

• RFIC N7505

• Front End Module (FEM) N7520

• WCDMA PA N7540

Discrete components
In addition to the key-components, there are a number of discrete components (resistors, inductors and
capacitors) for which troubleshooting is done mainly by visual inspection.

Capacitors: check for short circuits.

Resistors: check value with an ohm meter.

Note: In-circuit measurements should be evaluated carefully

Measuring equipment
All measurements should be done using:

• An oscilloscope for low frequency and DC measurements. Recommended probe: 10:1, 10Mohm//8pF.

• A radio communication tester including RF generator and spectrum analyser, for example Rohde & Schwarz
CMU200. (Alternatively a spectrum analyser and an RF generator can be used. Some tests in this guide are
not possible to perform if this solution is chosen).

Note: A mobile phone WCDMA transmitter should never be tested with full TX power (only it possible
to perform the measurements in a good RF-shielded room). Even low power WCDMA transmitters
may disturb nearby WCDMA networks and cause problems to 3G cellular phone communication in
a wide area.

Note: All measurements with an RF coupler should be performed in an RF-shielded environment
because nearby base stations can disturb sensitive receiver measurements. If there is no possibility
to use RF shielded environment, testing at frequencies of nearby base stations should be avoided.

Level of repair
The scope of this guideline is to enable repairs at key-component level. Some key-components are not
accessible, i.e. not replaceable. Please refer to the list of Non-replaceable RF components (page 4–8).

General information on RF troubleshooting
The RF frontend solution has two signal paths to the antenna feed points. One signal path is for GSM and
WDCMA 2100 Tx (WCDMA transmitter path) and the second one is for WCDMA 2100 RX (WCDMA receiver path).
This fact has to be considered when connecting measurement equipment to the product.
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This frontend solution needs some attention for the selection and connection of RF test equipment.

Connection of multiport test equipment (for example R&S CMU 200) is shown in the figure below.

Port 2 is configured as out and in port; port 3 is configured as out port.

Connection of single port test equipment (Ansitsu) is shown in the figure below.

Figure 28 GSM test

Figure 29 WCDMA 2100 test

Port 2 is configured as out and in port; port 3 is configured as out port.
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RF key components

Figure 30 RF key components - top
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Figure 31 RF key components - bottom

Non-replaceable RF components
The following RF components cannot be replaced because of their location on the PWB:

Non-replaceable RF components

N7540 L7528 L7506 C7583

C7548 L7527 G7501 R7502

C7550 C7525 C7500 L7503

L7550 L7510 R7501 R7503

R7541 Z7521 C7513 C7518
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Non-replaceable RF components

C7547 T7502 C7519 Z7580

N7541 L7590 C7520 Z7600

L7540 C7590 C7580 C7524

C7521 Z7582 C7582 L7526

L7529 L7502 C7581

General voltage checking

Steps
1. Set up the main board in the module jig. The phone should be in local mode.

2. Check the following:

# Signal name Test point Voltage (all bands)

1 VCTOXO supply R7501 2.5 V

2 Ahneus supply from Dc/Dc
conv.

C7590 3.2 V

3 FEM supply L7510 3.9 V

4 WCDMA PA supply from
Dc/Dc conv.

C7543 0 V (minimum 1.3 V
when transmitting)

5 Vbat at WCDMA PA C7547 3.9 V

6 Supply input to DC/DC
conv (N7590)

L7592 3.9 V

* With these settings, the result should be 1.3 V.
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Figure 32 General voltage checking test points

Phoenix self tests

Context
Always start the troubleshooting procedure by running the Phoenix self tests. If a test fails, please follow the
diagram below.

If the phone is dead and you cannot perform the self tests, go to Dead or jammed device troubleshooting.
in the baseband troubleshooting section.
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Troubleshooting flow

 Receiver troubleshooting

Introduction to receiver (RX) troubleshooting
RX can be tested by making a phone call or in local mode. For the local mode testing, use Phoenix service
software.
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The main RX troubleshooting measurement is RSSI reading. This test measures the signal strength of the
received signal. For GSM RSSI measurements, see GSM RX chain activation for manual measurements / GSM
RSSI measurement (page 4–17). For a similar test in WCDMA mode, see WCDMA RSSI measurement
(page 4–20).

VCTCXO troubleshooting

Troubleshooting flow
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RX GSM850 troubleshooting

Troubleshooting flow
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RX GSM900 troubleshooting

Troubleshooting flow
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RX GSM1800 troubleshooting

Troubleshooting flow
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RX GSM1900 troubleshooting

Troubleshooting flow
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GSM RX chain activation for manual measurements/GSM RSSI measurement

Prerequisites
Make the following settings in Phoenix service software:

Setting GSM850 GSM900 GSM1800 GSM1900

Phoenix Channel 190 37 700 661

Signal generator
to antenna
connector

881.66771MHz
(67.71kHz offset)
at -60dBm

942.46771MHz
(67.71kHz offset)
at -60dBm

1842.86771MHz
(67.71kHz offset)
at -60dBm

1960.06771MHz
(67.71kHz offset)
at -60dBm

Steps
1. Set the phone to local mode.

2. Activate RSSI reading in Phoenix (Testing→GSM→RSSI reading )

Results
The reading should reflect the level of the signal generator (-losses) +/- 5 dB.

When varying the level in the range -30 to -102 dBm the reading should then follow within +/-5 dB.
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WCDMA receiver troubleshooting

Troubleshooting flow
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WCDMA RX chain activation for manual measurement

Prerequisites
Make the following settings in Phoenix service software:

Setting WCDMA2100

Phoenix Channel 10700

Signal generator to antenna connector 2141.0 MHz

Steps
1. Via Phoenix Testing menu, choose WCDMA/RX Control.

2. In the RX control window, make the following settings:

3. Click Start to activate the settings.

If the settings are changed later on (for example, change of channel) you have to click Stop and Start
again.

Note: Clicking Stop also disables TX control if it was active.

4. Set the following RF generator settings:
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Figure 33 WCDMA RX generator settings

WCDMA RSSI measurement

Prerequisites
WCDMA RX must be activated before RSSI can be measured. For instructions, please refer to WCDMA RX chain
activation (page 4–19).

Steps
1. From the Phoenix testing menu, select WCDMA→RX Power measurement

2. In the RX Power measurement window, select:

• Mode: RSSI

• Continuous mode

3. Click Start to perform the measurement.

 Transmitter troubleshooting

General instructions for transmitter (TX) troubleshooting
Please note the following before performing transmitter tests:

• TX troubleshooting requires TX operation.

• Do not transmit on frequencies that are in use!

• The transmitter can be controlled in local mode for diagnostic purposes.

• The most useful Phoenix tool for GSM transmitter testing is “RF Controls”; in WCDMA transmitter testing
the best tool is “TX Control”.

• Remember that re-tuning is not a fix! Phones are tuned correctly in production

RM-179; RM-223
RF troubleshooting

Page 4 –20 COMPANY CONFIDENTIAL Issue 1
Copyright © 2007 Nokia. All rights reserved.



Note: Never activate the GSM or WCDMA transmitter without a proper antenna load. Always connect
a 50 Ω load to the RF connector (antenna, RF-measurement equipment or at least a 2 W dummy
load); otherwise the GSM or WCDMA Power amplifier (PA) may be damaged.

GSM transmitter troubleshooting

Steps
1. Set the phone to local mode.

2. Activate RF controls in Phoenix (Testing→GSM→Rf Controls ).

Use the following settings:

3. Check the basic TX parameters (i.e. power, phase error, modulation and switching spectrum), using a
communication analyser (for example CMU200).
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Figure 34 Typical readings

4. Change the power level (RF controls) and make sure the power reading follows accordingly.

Next actions
You can troubleshoot the GSM transmitter for each GSM band separately, one band at a time. If you want to
troubleshoot GSM850, GSM1800 or GSM1900, change the band with the RF controls and set the
communication analyser accordingly.

RM-179; RM-223
RF troubleshooting

Page 4 –22 COMPANY CONFIDENTIAL Issue 1
Copyright © 2007 Nokia. All rights reserved.



TX 850/900 troubleshooting

Troubleshooting flow
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TX 1800/1900 troubleshooting

Troubleshooting flow
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Checking antenna functionality
The device has a main GSM and WCDMA 2100 antenna. The main antenna is the visible gold structure on the
black plastic carrier. The main antenna has six connections to the PWB via C-clips. The main antenna consist
of two radiator structures for quadband GSM/ WCDMA 2100 TX and a WCDMA 2100 RX.

The BT/Wlan antenna is the visible flexid PWB covered with black paint. The antenna is connected to the PWB
with two C-clips.

Main antenna functionality
The main antenna is an active antenna. It is functioning normally when the feeds and the GND have proper
connection to the PWB.

The radiator is made from a durable gold colored conductive layer. This layer has to be visually intact.

The main antenna functionality must be checked by measuring the transmitted power with an RF coupler at
GSM 1800 channel 610 and GSM 900 channel 37. The test in GSM 1800 and GSM 900 take care that the active
path (XGND) of the antenna is working.

Figure 35 Main antenna
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BT/WLAN antenna functionality
The BT/WLAN antenna is functioning normally when the feeds and the GND have proper connection to the
PWB. The radiator is made from a flexid PWB which has to be visually intact.

WCDMA transmitter troubleshooting

Steps
1. Set the phone to local mode.

2. In Phoenix, select Testing→WCDMA→TX control .

3. Use the following settings in the TX control window:
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Figure 36 Phoenix WCDMA TX control window

Note: Use the Start level option to set the TX power level.

4. Click Send to enable the settings and activate TX.

If settings are changed (eg. new channel), you have to click RF Stop and Send again.

5. Use the CMU200 to check the WCDMA power.
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Figure 37 WCDMA power window
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WCDMA transmitter troubleshooting flowchart

Troubleshooting flow

 RF tunings

Introduction to RF tunings
Important: Only perform RF tunings if:
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• one or more of the RF components have been replaced

• flash memory chip is replaced or corrupted.

RF calibration is always performed with the help of a product-specific module jig, never with an RF coupler.
Using an RF coupler in the calibration phase will cause a complete mistuning of the RF part.

Important: After RF component replacements, always use autotuning. Manual tunings are only
required in rare cases.

Cable and adapter losses
RF cables and adapters have some losses. They have to be taken into account when the phone is tuned. As
all RF losses are frequency dependent, the user has to act very carefully and understand the measurement
setup.

For RF attenuations of the module jig, please refer to the Service tools section.

Autotuning for BB5
This phone can be tuned automatically.

Autotune is designed to align the phone's RF part easier and faster. It performs calibrations, tunings and
measurements of RX and TX. The results are displayed and logged in a result file, if initiated.

Hardware set up
Hardware requirements for auto tuning:

• PC (Windows 2000/XP) with GPIB card

• Power supply

• Product specific module jig

• Cables: XRF-1 (RF cable), USB cable, GBIP cable and DAU-9S

• Signal analyser (TX), signal generator (RX) and RF-splitter or one device including all.

Figure 38 Auto tuning concept with CMU200

Phoenix preparations
Install the phone-specific data package. This defines the phone-specific settings.

Auto tuning procedure
1 Make sure the phone (in the jig) is connected to the equipment. Else, some menus will not be shown in

Phoenix.
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2 To go to autotune, select Tuning (Alt-U) > Auto-Tune (Alt-A) from the menu.

3 Remember to set the correct attenuation values before autotuning.

4 To start autotuning, click the Tune button.

 System mode independent manual tunings

RF channel filter calibration

Context
Rf channel filter calibration tunes the internal low pass filters of the RF ASIC, that limit the bandwidth of BB
IQ signals.

Table 5 Rf channel filter calibration tuning limits

Min Typ Max

Tx filter 0 10 31

RX mixer 0 13 31

Rx filter 0 16 31

Steps
1. From the Operating mode drop-down menu, set mode to Local.

2. Choose Tuning→Rf Channel Filter Calibration .

3. Click Tune.

4. To save the values to the PMM (Phone Permanent Memory) area, click Write.

5. To close the Rf Channel Filter Calibration window, click Close.

Results

Figure 39 Rf channel filter calibration typical values

PA (power amplifier) detection

Context
The PA detection procedure detects which PA manufacturer is used for phone PAs.

If a PA is changed or if the permanent memory (PMM) data is corrupted, PA detection has to be performed
before Tx tunings.
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Steps
1. From the Operating mode drop-down menu, set mode to Local.

2. Choose Tuning→PA Detection .

3. Click Tune.

4. Check that the detected PA manufacturers are corresponding to the actual chips on the board.

5. To end the procedure, click Close.

 GSM receiver tunings

Rx calibration (GSM)

Context
Rx Calibration is used to find out the real gain values of the GSM Rx AGC system and tuning response of the
AFC system (AFC D/A init value and AFC slope)

Steps
1. Connect the GSM connector of the module jig to a signal generator.

2. Start Phoenix service software.

3. From the Operating mode drop-down menu, set mode to Local.

4. Choose Tuning→GSM→Rx Calibration .
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5. Click Start.

6. Connect the signal generator to the phone, and set frequency and amplitude as instructed in the
Rx Calibration with band EGSM900 (step 1-3) pop-up window.

Important: The calibration uses a non-modulated CW signal. Increase the signal generator level by
cable attenuation and module jig probe attenuation.
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7. To perform the tuning, click OK.

8. Check that the tuning values are within the limits specified in the following table:

Table 6 RF tuning limits in Rx calibration

Min Typ Max Unit

GSM850

AFC Value (init) -200 -80..40 200 dB

AFC slope 0 108..121 200 dB

RSSI (AGC-0) 106 107..110 114 dB

GSM900

AFC Value (init) -200 -105..62 200 dB

AFC slope 0 122 200 dB

RSSI (AGC-0) 106 107...110 114 dB

GSM1800

RSSI (AGC-0) 105 105...109 114 dB

GSM1900

RSSI (AGC-0) 105 105...109 114 dB
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9. Click Next to continue with GSM1800 Rx tuning.

Next actions
Repeat steps 6 to 9for GSM1800 and GSM1900

Rx band filter response compensation (GSM)

Prerequisites
Rx calibration must be performed before the Rx band filter response compensation.

Context
On each GSM Rx band, there is a band filter in front of the RF ASIC front end. The amplitude ripple caused by
these filters causes ripple to the RSSI measurement, and therefore calibration is needed.

The calibration has to be repeated for each GSM band.

Steps
1. Connect the GSM connector of the module jig to a signal generator.

2. Start Phoenix service software.

3. From the Operating mode drop-down menu, set mode to Local.
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4. Select GSM900 band.

5. Choose Tuning→GSM→Rx Band Filter Response Compensation .

6. Select Tuning mode: manual

7. Click Start.

8. Connect the signal generator to the phone, and set frequency and amplitude as instructed in the Rx Band
Filter Response Compensation for EGSM900 pop-up window, step 1-3.
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9. To perform tuning, click OK.

10. Go through all 9 frequencies. The following table will be shown:

11. Check that the tuning values are within the limits specified in the following table:

Min Typ Max Unit

GSM850

Ch. 118/867.26771 MHz -6 -1 2 dB

Ch. 128/869.26771 MHz -3 0 2 dB

Ch. 140/871.66771 MHz -3 0 2 dB

Ch. 172/878.06771 MHz -2 0 2 dB

Ch. 190/881.66771 MHz -2 0 2 dB

Ch. 217 / 887.06771 MHz -2 0 2 dB

Ch. 241/891.86771 MHz -3 0 2 dB

Ch. 251/893.86771 MHz -3 0 2 dB

Ch. 261/895.86771 MHz -6 -1 -2 dB

GSM900

Ch. 965 / 923.26771 MHz -6 -1 2 dB

Ch. 975 / 925.26771 MHz -3 0 2 dB

Ch. 987 / 927.66771 MHz -3 0 2 dB

Ch. 1009 / 932.06771 MHz -2 0 2 dB
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Min Typ Max Unit

Ch. 37 / 942.46771 MHz -2 0 2 dB

Ch. 90 / 953.06771 MHz -2 0 2 dB

Ch. 114 / 957.86771 MHz -3 0 2 dB

Ch. 124 / 959.86771 MHz -3 0 2 dB

Ch. 136 / 962.26771 MHz -6 -1 2 dB

GSM1800

Ch. 497 / 1802.26771 MHz -6 -1 3 dB

Ch. 512 / 1805.26771 MHz -3 0 3 dB

Ch. 535 / 1809.86771 MHz -3 0 3 dB

Ch. 606 / 1824.06771 MHz -3 0 3 dB

Ch. 700 / 1842.86771 MHz -3 0 3 dB

Ch. 791 / 1861.06771 MHz -3 0 3 dB

Ch. 870 / 1876.86771 MHz -3 0 3 dB

Ch. 885 / 1879.86771 MHz -3 0 3 dB

Ch. 908 / 1884.46771 MHz -6 -1 3 dB

GSM1900

Ch. 496 / 1927.06771 MHz -6 -1 2 dB

Ch. 512 / 1930.26771 MHz -3 0 2 dB

Ch. 537 / 1935.26771 MHz -3 0 2 dB

Ch. 586 / 1945.06771 MHz -3 0 2 dB

Ch. 661 / 1960.06771 MHz -3 0 2 dB

Ch. 736 / 1975.06771 MHz -3 0 2 dB

Ch. 794 / 1986.66771 MHz -3 0 2 dB

Ch. 810 / 1989.86771 MHz -3 0 2 dB

Ch. 835 / 1994.86771 MHz -6 -1 2 dB

12. If the values are within the limits, click Next to continue to the next band.

Next actions
Repeat the steps 8 to 12 for GSM1800 and GSM1900.

 GSM transmitter tunings

Tx IQ tuning (GSM)

Context
The Tx path branches to I and Q signals at RF I/Q modulator. Modulator and analog hardware located after
it cause unequal amplitude and phase disturbance to I and Q signal paths. Tx IQ tuning balances the I and Q
branches.
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Tx IQ tuning must be performed for all GSM bands.

Steps
1. Start Phoenix service software.

2. From the Operating mode drop-down menu, set mode to Local.

3. Choose Tuning→GSM→Tx IQ Tuning .

4. Select Mode: Automatic.

5. Select Band: GSM900 and click Start.

6. Click Next to start GSM1800 band TX IQ tuning.

7. Click Next to start GSM1900 band TX IQ tuning.

8. ClickFinish and then Close.

Next actions
Tuning sliders should be close to the center of the scale after the tuning and within the limits specified in
the following table. If they are not within the limits, check Tx IQ quality manually.

Min Typ Max Unit

GSM850

I DC offset / Q DC
offset

-6 -4 6 %

Ampl -1 0 1 dB

Phase 85 90 95 °

GSM900
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Min Typ Max Unit

I DC offset / Q DC
offset

-6 -4 6 %

Ampl -1 0 1 dB

Phase 85 90 95 °

GSM1800/GSM1900

I/Q DC -6 0.5 6 %

Ampl -1 0 1 dB

Phase 95 100 110 °

Tx power level tuning (GSM)

Context
Because of variations at the IC (Integrated Circuit) process and discrete component values, the actual
transmitter RF gain of each phone is different. Tx power level tuning is used to find out mapping factors
called 'power coefficients’. These adjust the GSM transmitter output power to fulfill the specifications.

For EDGE transmission, the bias settings of the GSM PA are adjusted in order to improve linearity. This affects
the PA gain and hence the power levels have to be aligned separately for EDGE transmission.

Tx power level tuning has to be performed on all GSM bands.

Steps
1. Connect the phone to a spectrum analyzer.

2. Start Phoenix service software.

3. From the Operating mode drop-down menu, set mode to Local.

4. Choose Tuning→GSM→Tx Power Level Tuning .
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5. Click Start.l

6. Set the spectrum analyzer for power level tuning:

Frequency Channel frequency:

• 836.6 MHz GSM850

• 897.4MHz GSM900

• 1747.8MHz GSM1800

• 1880MHz GSM1900

Span 0 Hz

Sweep time 2ms

Trigger Video triggering (-10dBm)

Resolution BW 3MHz

Video BW 3MHz

Reference level offset sum cable attenuation with module jig
attenuation

Reference level 33dBm

A power meter with a peak power detector can be also used. Remember to take the attenuations into
account.
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7. Set the tuning targets according to the values in the table below

GMSK 1 slot 2 slot 3 slot

850 32.5 dBm 32.5 dBm 30.5 dBm

900 32.5 dBm 32.5 dBm 30.5 dBm

1800 29.5 dBm 29.5 dBm 29.5 dBm

1900 29.5 dBm 29.5 dBm 29.5 dBm

EDGE 1 slot 2 slot 3 slot

850 26,5dBm 26,5dBm 26,5dBm

900 26,5dBm 26,5dBm 26,5dBm

1800 25dBm 25dBm 25dBm

1900 25dBm 25dBm 25dBm

8. Adjust power for all bold power levels to correspond the Target dBm column by pressing + or – keys.

9. If all bold power levels are adjusted, click Next to continue with GSM850 EDGE.

10. Adjust power for all bold power levels to correspond the Target dBm column by pressing + or – keys.

Next actions
Continue tuning the bold power levels of the GSM900, GSM1800 and GSM1900 bands. You will see this
message, if finished successfully:

 WCDMA receiver tunings

RX calibration (WCDMA)

Context
Rx calibration tuning routine calculates the real gain values of the WCDMA Rx AGC system. There is also a SAW
filter between front end LNA and mixer in the receive chain, which causes ripple in the RSSI measurement,
this is calibrated out. The SAW filter is intergated into RF ASIC N7500.

Rx calibration can be done in two different ways, manual tune and sweep mode tune. If the signal generator
in use supports frequency sweep table, the calibration is done in one step.
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Steps
1. For manual tuning, set mode to Local in the Operating Mode dropdown menu.

2. In the Tuning menu, choose WCDMA→Rx Calibration  .

3. Click Start.

4. Select Band "WCDMA 2100".

5. Click Tune.

6. Setup the signal generator to correspond with the values on the, Rx Calibration pop-up window and click
OK.

Figure 40 Pop-up window for WCDMA2100
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7. Repeat step 6. for Middle and High channels.

8. Ensure Tuning Results are within limits specified in the table below:

If values are OK, click Write to save the values.

Band Min Typ Max Unit

Rx chain 2100 -6 1.5 to 3.5 6 dB

Low
Frequency

-5 -0.7 to 4.0 5

High
Frequency

-5 -0.7 to 4.0 5

Alternative steps
• For sweep mode tuning, set Mode to Local in the Operating Mode dropdown menu.

• In the Tuning menu, choose WCDMA→ Rx Calibration .

• Click Start.

• Select Band, "WCDAM2100".

• Check the Sweep Mode box.

• Click Tune.
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• Setup the signal generator to correspond with the values on the Rx Calibration pop-up window and click
OK.

Figure 41 Pop-up window for WCDMA2100

• Ensure Tuning Results are within limits specified in the table above: If values are OK, click Write to save
the values to the phone.

• Close the tuning window.

 WCDMA transmitter tunings

Tx AGC & power detector (WCDMA)

Context
Tx AGC & power detector tuning has two purposes:

• to enable the phone to select the correct TxC value accurately in order to produce the required RF level

• to enable the phone to measure its own transmitter power accurately

There are two ways to perform the tuning. For an alternative method, see Alternative steps (page 4–51).

Steps
1. From the Operating mode drop-down menu, set mode to Local.

2. Choose Tuning→WCDMA→Tx AGC & Power Detector.

3. Click Start.

4. In theWide Range pane, click Tune (the leftmost Tune button).

RM-179; RM-223
RF troubleshooting

Issue 1 COMPANY CONFIDENTIAL Page 4 –45
Copyright © 2007 Nokia. All rights reserved.



5. Set up the spectrum analyzer in the following way:

6. After setting the spectrum analyzer, click OK.

7. Measure the power levels with a marker.

Take the first measurement from 250 us after the trigger, the second after 750 us, the third after 1220
us and so on for every 500 us until the table is filled.

Note: It must be possible to measure power levels down to –68 dBm. The measured power levels
must be monotonously decreasing.

Make sure that the marker is not measuring the level of noise spikes on lower levels.
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8. Fill in the power level values (in dBm) to the Wide Range table.

9. In the Wide Range pane, click Calculate.

10. In the High Burst pane, click Tune.

11. Adjust the spectrum analyzer according to the following settings:
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12. Measure the power levels with a marker.

Take the first measurement from 250 us after the trigger, the second after 750 us, the third after 1220
us and so on for every 500 us until the table is filled.

Figure 42 High burst measurement

13. In the High Burst pane, click Calculate.

14. Check that the calculated values are within the limits specified in the following table:

Min Max

C0-high -0.5 5

C1-high -50 50

C2-high 400 900

C0-mid -0.7 0.7

C1-mid 0 50

C2-mid 400 900

C0-low -4 4

C1-low -400 440

C2-low -10000 15000
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Min Max

Det-k 100 220

Det-b 0 150

15. To save the coefficients to the phone, click Write.

16. To close the Tx AGC & Power Detector window, click Close.

17. Choose Testing→WCDMA→ Tx Control.

18. Select the Algorithm mode tab.

19. Write the target power level 25 dBm to the Start level line and check the Max power limit check box
(detector calibration check).

20. Setup the spectrum analyzer with the following settings:

Center frequency: 1950.3 MHz

Span: 0 Hz

Reference level offset: Cable attenuations + adapter attenuation

Reference level: 25 dBm or -20 dBm depending on the level
measured

Input attenuation: Automatic

Resolution bandwidth: 5 MHz

Video bandwidth: 5 MHz

Sweep time: 20 ms
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Detector: RMS detector

Average: No

Trigger: Free run

21. Click Send.

22. Measure the WCDMA output power.

It should be around 23.5 dBm.

23. Click RF Stop and uncheck the Max power limit check box.

24. Repeat steps 19 to 23 for levels +21, +7, 0, -20 and –40 dBm.

The measured output power may not differ more than +-2 dB from the requested value at level +21 dBm
and no more than +-4 dB on lower levels.

Remember to stop the RF before sending new data.

Alternative steps
• Measure the wide range levels normally and write down the levels that are possible to measure.

• Click Finish.

• Click Options.

• Change the first wide range DAC value to 573 and change the number of tuning steps to 21.

• Change the spectrum analyzer reference level to –20 dBm and adjust the input attenuator to the lowest
value possible.

• In the Wide Range pane, click Tune and fill in the rest of values starting from the 19th level.

Tx band response calibration (WCDMA)

Context
The purpose of this tuning operation is to calibrate the WCDMA Tx performance. It defines the power detector
and Tx frequency compensation values. However, before starting this tuning procedure, it is necessary to
carry out Tx AGC & Power Detector Calibration tuning. This is because its results will be needed for this tuning
operation.

• In the Tuning Settings pane, it is possible to edit the numbers of channels used in this tuning operation.

• If the Calibrate Detector Response check box is checked, only Tx response is calibrated. Zero is written
to the power detector compensation values block in the permanent memory (PM) of the terminal.

• Detector Calibration level shows the power level used for calibrating the power detector in this tuning
procedure.

• Tx Calibration level shows the power level used for calibrating tx frequency in this tuning procedure.

• In the Measured Power Levels pane, you can insert the dBm values read from the power meter.

• In the Tuned Values pane, the values that are stored in the permanent memory (PM) of the terminal in
Current columns are shown.

• New values are added to New column when the Calculate button is clicked.

• The Abort button aborts the tuning operation without saving the tuned values.

• The Read button reads the tuned values in the PM of the terminal, and displays them in the Tuned
Values pane in in the Current column.

Steps
1. Start Phoenix service software.
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2. Choose File→Scan Product  .

3. From the Operating mode drop-down menu, set mode to Local.

4. Choose Tuning→WCDMA→R4 Tx Band Response Calibration .

5. Click Start.

The current values are shown in the Tuned Values pane.

6. Click Tune.

7. Connect the power meter to the terminal, and set it to Channel Mid frequency.

8. Read the values of slot 1 and slot 2 from the power meter and enter them to Middle power level fields
in the Measured Power Levels pane.

Slot 1 is used for detector calibration and slot 2 for Tx calibration.

9. Click Next.

10. Switch the power meter to Channel Low frequency.

11. Read the values from the power meter, and enter them to Low power level fields.

12. Switch the power meter to Channel High frequency.

13. Read the values from the power meter, and enter them to High power level fields.

14. Click Next.

15. Click Calculate.

The tuned values are shown in the Tuned Values pane in the New column.

16. Check that the tuned values are within the limits presented in the following table. If they are OK, click
Yes.
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Min Max

Tx Freq Comp (the first and last
value)

-4 +4

17. To save the tuned values to the terminal, click Write.

18. Close the Tx Band Response Calibration window.

Tx LO leakage (WCDMA)

Context
The purpose of Tx LO leakage tuning is to minimize the carrier leakage of the IQ-modulator which is caused
by the DC offset voltages in the Tx IQ-signal lines and in the actual IQ modulator.

The tuning improves WCDMA Tx AGC dynamics at low power levels. A self-calibration routine selects the best
combination for internal control words in order to produce minimum LO leakage.

Steps
1. From the Operating mode drop-down menu, set mode to Local.

2. Choose Tuning→WCDMA→ Tx LO Leakage .

3. Click Tune.

4. To end the tuning, click Close.
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 Camera construction
This section describes the mechanical construction of both camera modules for getting a better
understanding of the actual mechanical structure of each module.

 Main camera construction

Figure 43 Camera module cross section and assembly principle

Figure 44 Main camera module bottom view including serial numbering

The camera module as a component is not a repairable part, meaning that the components inside the module
may not be changed. Cleaning dust from the front face is allowed only. Use clean compressed air.
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The camera module uses socket type connecting. For versioning, laser marked serial numbering is used on
the PWB.

The main parts of the module are:

• Lens unit including lens aperture.

• Infrared filter; used to prevent infrared light from contaminating the image colors. The IR filter is glued
to the EMI shielded camera body.

• Camera body; made of conductive metallized plastic and attached to the PWB with glue.

• Sensor array including DSP functions is glued and wire-bonded to the PWB.

• PWB, FR-4 type

• Socket type connection

• Laser-marked serial numbering on PWB (for versioning)

• Passive components

• Camera protection window; part of the phone cover mechanics

• Dust gasket between the lens unit and camera protection window

 Secondary camera construction
The camera module as a component is not a repairable part because it is soldered on LID PWB. To exchange
front camera module the whole LID PWB has to be exchanged. Cleaning dust from the front face is allowed
only. Use clean compressed air.

The front camera module is constructed from 3 major components: lens unit, sensor and shield plate. The
lens unit includes the lens holder, lens, aperture and IR-cut glass. Sensor is glued on lens holder. Both are
covered with the shield plate. It also includes the module marking (1pin position).

Figure 45 Front camera module cross section and assembly principle
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 Camera viewfinder troubleshooting

Troubleshooting flow
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 Bad camera image quality troubleshooting

Troubleshooting flow
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 Main camera troubleshooting

Troubleshooting flow
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 Main camera baseband HW troubleshooting

Troubleshooting flow
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 Secondary camera troubleshooting

Troubleshooting flow
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 Secondary camera baseband HW troubleshooting

Troubleshooting flow
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 Flash LED troubleshooting

Introduction to flash LED troubleshooting
A fault or complaint associated to LED flash operation can be roughly categorized into two subgroups:

1 Flash is not functional at all (no light output at all).

2 Images can be taken and they are recognizable but for some reason the quality of images is degraded.

Examples of quality degradations:

• Brightness is not sufficient.

• Brightness is too much = overexposed.

• Only portions of the image brightness (e.g., left, right, top or bottom) are proper and the rest are not.

The quality of an image is very difficult to measure quantitatively, and even comparative measurements are
difficult (comparing two images), if the difference between reference images is small. If a user is not satisfied
with his/her device's image quality, it is fairly difficult to accurately test the device and get an exact result,
which would tell if the device is working properly.

Often subjective evaluation has to be used for finding out if there is something wrong in the flash. Some
training or experience of a correctly operating reference device may be needed in order to detect possible
faults. It is easy for a user to take low quality images in bad conditions. Therefore, the camera and flash
operation has to be always checked in constant conditions (lighting, temperature) or by using a second,
known-to-be good reference device.

Flash LED and image taking conditions
This section describes some of common factors, which may cause poor image quality if not taken into account
by end users when taking pictures, and may therefore result in complaints. The items described are normal
to the camera and LED flash operation and do not raise a need for servicing the components.

Figure 46 Example of a good quality image taken with the flash LED
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Distance to the target (too close)
There is no feedback in the flash system, which means that the light output is constant in every situation.
This causes the images to overexposure, when shot from close distance. The flash LED is designed to work
optimally between distances of 70 cm – 1.2 m.

This is normal behaviour; do not change the flash module.

Figure 47 overexposed image

Distance to the target (too far away):
The power of the white LED flash is still very modest compared to xenon flash technology. Even with full
power, the maximum distance for an acceptable image quality is roughly 1.2 m. If the distance is greater
than 1.2 m, the images will appear dark and the noise level increases.

This is normal behaviour; do not change the flash module.
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Figure 48 Dark and noisy image

Shaken (= blurred) images
The traditional xenon flash has the advantage of stopping the movement. This is a result of an extremely
short and intense light pulse, which makes it possible for a camera to use very short exposure time. Due to
the weak output of the LED flash, the exposure time has to be actually increased in the viewfinder mode in
total blackness, instead of shortening it. This allows the sensor to integrate longer and collect more light but
this also easily creates blurred images if care is not taken.

In addition to the limitation due to small LED flash light, handshake owing to camcoder type product concept
and shutter button operation exists. These are not errors but a limitation of the product. No need to change
the LED flash module.
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Figure 49 Shaken image

Camera white balance failure and overexposure due to presence of ambient light
Because the spectral output of the flash is known, the white balance and the exposure control of the camera
work in optimal way with the flash in total blackness. This is why some of the pictures may fail (i.e. images
get a bit yellow or reddish, or greenish or bluish, depending on the ambient light characteristics, as well as
overexposed or underexposed).

If the flash works correctly in dark conditions, there is no need to change the flash module.
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Figure 50 Camera white balance failure and overexposure

Colour difference between different modules
There is some variation in the spectrum of the flash, which derives from the manufacturing process of the
white LEDs. Because of this variation, there may be some variation in the colour of the images as well.

This is normal behaviour; do not change the flash module.

Figure 51 Color difference between flash colour limit samples
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Flash LED construction

Figure 52 Mechanical construction of the flash LED module

Analysing image quality

Possible faults in image quality
When checking for possible errors in the flash functionality, knowing what error is suspected, significantly
helps the testing by narrowing down the number of possible test cases. The following types of image quality
problems may be expected to appear:

• LED module is not flashing at all

• Image colours are not good

• Flash power is weak

Testing flash module functionality

Context
With the help of this test you can check the flash module's overall functionality.

Always set the flash to FORCED FLASH mode when performing the test. The FORCED FLASH mode enforces the
LED module to flash, even if there is some ambient light present.

Steps
1. Take an image with the flash and monitor at same time whether the LED module flashes.
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Results
If the LED flashes normally, the overall functionality of the module is OK.

Testing image colours with flash

Context
With the help of this test you can check if the image colours are normal when using the flash.

Steps
1. Take an image of a target, which contains something white in total blackness from less than 1 m range.

Results
If the white target appears to be white, the flash is working correctly. However, remember that there is some
variation in the flash colour from module to module.

Testing flash power

Context
With the help of this test you can check if the flash is working with adequate power level.

Steps
1. Take an image with the flash in total blackness (ambient light <1 lux) of a target 80 cm - 1 m away.

Results
If the flash is working normally with adequate power level, the image is correctly exposed between distances
80 cm to 1 m.

Remember that the brightness level in the corners is always less than in the center of the image because of
camera and flash optics.
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Camera flash LED troubleshooting

Troubleshooting flow
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 Indicator LED troubleshooting
RM-179 implements a flash light for taking pictures in dark conditions and which is also used as notification
light in video recording mode. In notification mode flash LED is driven with torch current and PWM of 1/32
(up to 4,7mA). In this mode the logical input of EN1 is 1 and for EN2 it is 0. For notification light
troubleshooting, Camera flash LED troubleshooting (page 5–20) flow chart can be used.
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 Introduction

Phone description
RAPIDO is the main digital baseband ASIC in the phone. It contains functionality for both WCDMA and GSM
EDGE.

AVILMA is mainly the audio ASIC in the phone and BETTY is basically the energy management controller for
the phone.

Bluetooth and FM radio are physically integrated in one single ASIC.

Key components

Function Description Item ref

Baseband ASIC AVILMA

BETTY

N2200

N2300

RF ASIC Ahneus N7505

Processor RAPIDO D2800

Camera accelerator HWA STV984N D2500

PA GSM Front end module (FEM), quad band N7520

PA WCDMA N7540

Oscillators VCTCXO

Balun GSM

Balum WCDMA

G7501

T7502

T7580

Memory 768Mb DDR SDRAM + 1Gb NAND FLASH Combo D3000

Back-up battery RTC back-up battery 311 G2200

FM radio BTHFM1.0 module D6000

Bluetooth BTHFM1.0 module D6000

Open/closed slider
detection

Hall sensor N2403

Battery BP-6MT

Battery connector Tabby blade interface X2070

RF connector X7501
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System module block diagram
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Board and module connections

 Energy management

Battery and charging

BP-6MT battery
The phone is powered by a BP-6MT battery block. It provides a capacity of 1050mAh minimum and contains
a BSI resistor for the battery identification. Its battery interface is based on blade type connector where the
transceiver side has blades and the counter parts are on battery side.

Figure 53 Battery pin order
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The battery temperature is estimated by measuring separate battery temperature NTC via the BTEMP line.
This is located on the main PWB, at the place where the phone temperature is closest to the battery
temperature.

Battery connector
The battery connector is a blade connector. It has three blades;

• BSI (Battery size indicator)

• GND (Ground)

• VBAT (Battery voltage)

The BSI line is used to recognize the battery capacity by a battery internal pull down resistor.

Figure 54 Battery connector

Charging
This phone is charged through the smaller Nokia standard interface (2.0 mm plug). The wider standard
charger (3.5 mm) can be used together with the CA-44 charger adapter.

Figure 55 Small (right) and wide (left) charger plug

Charging is controlled by energy management, and external components are needed to protect the baseband
module against EMC, reverse polarity and transient frequency deviation.

Backup battery
When the main battery is not attached EM ASIC (N2200) goes in backup mode using back-up battery that
supplies voltage to RTC in EM ASIC (N2200).
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Normal and extreme voltages
Energy management is mainly carried out in the two Application Specific Integrated Circuits (ASICs) BETTY
and AVILMA. These two circuits contains a number of regulators. In addition there are some external
regulators too.

In the table below, normal and extreme voltages are shown when a BP-6MT battery is used.

Table 7 Nominal voltages

Voltage Voltage [V] Condition

General Conditions

Nominal voltage 3.700

Lower extreme voltage 3.145

Higher extreme voltage

4.230(fast charging)

HW Shutdown Voltages

Vmstr+ 2.1 ± 0.1 Off to on

Vmstr- 1.9 ± 0.1 On to off

SW Shutdown Voltages

Sw shutdown 3.25 In call

Sw shutdown 3.25 In idle

Min Operating Voltage

Vcoff+ 2.9 ± 0.1 Off to on

Vcoff- 2.6 ± 0.1 On to off

Power key and system power-up
When the battery is placed in the phone the power key circuits are energized. When the power key is pressed,
the system boots up (if an adequate battery voltage is present).

Power down can be initiated by pressing the power key again (the system is powered down with the aid of
SW). The power key is connected to EM ASIC N2200 (AVILMA) via PWRONX signal.

Modes of operation

Mode Description

NO_SUPPLY (dead) mode means that the main battery is not present or its voltage is too low (below
N2200 AVILMA master reset threshold) and that the back-up battery voltage is too low.

BACK_UP The main battery is not present or its voltage is too low but back-up battery voltage is
adequate and the 32 kHz oscillator is running (RTC is on).

PWR_OFF In this mode (warm), the main battery is present and its voltage is over N2300 BETTY
master reset threshold. All regulators are disabled, PurX is on low state, the RTC is on
and the oscillator is on. PWR_OFF (cold) mode is almost the same as PWR_OFF (warm),
but the RTC and the oscillator are off.
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Mode Description

RESET RESET mode is a synonym for start-up sequence. RESET mode uses 32 kHz clock to count
the REST mode delay (typically 16ms).

SLEEP SLEEP mode is entered only from PWR_ON mode with the aid of SW when the system’s
activity is low.

FLASHING FLASHING mode is for SW downloading.
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Power distribution
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Clocking scheme
The BT module uses two clock signals (Ref_clk = 38.4 MHz and Sleepclock = 32.768 KHz) which are provided
by the WLAN-module (TCXO).

Figure 56 Clocking scheme

 Bluetooth
Bluetooth provides a fully digital link for communication between a master unit (the phone) and one or more
slave units (e.g. a wireless headset). Data and control interface for a low power RF module is provided by the
module.

The Bluetooth is physically integrated with the FM radio into one single module. From a functional point of
view they, however, have nothing in common.
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Figure 57 Bluetooth hardware block diagram

 FM radio
The FM radio is physically integrated with the Bluetooth into one single module. From a functional point of
view they, however, have nothing in common.
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The FM radio is an integrated circuit, controlled by MCU software through a serial bus interface. The wires of
the headset are used as elements of the antenna, and no other antenna is needed for FM radio reception.

The FM radio is provided with VAUX (2V8).

The radio has an automatic band search function, which can search for a strong station.

 WLAN
WLAN engine is divided into STLC4550 WLAN transceiver module and radio front-end module (FEM) RF5924.

STMicroelectronics Phaser STLC4550 is a three-die multichip module, partitioned to radio, baseband and
energy management die. STLC4550 is packaged to 8.5 mm x 8.0 mm x 1.4 mm 240-ball 0.5 mm pitch LFBGA.

STLC4550 implements 802.11b/g WLAN radio for embedded, low-power and small form factor mobile
applications. STLC4550 conforms to the IEEE 802.11b/g protocols operating in 2.4 GHz band supporting OFDM
data rates of 54, 48, 36, 24, 18, 12, 9, and 6 Mbps as well as CCK data rates of 11 and 5.5 Mbps and legacy
data rates of 2 and 1 Mbps. IEEE802.11e/i protocol extensions are included to implement quality of service
(QoS) and security functions.

STLC4550 has a fully integrated radio chip including a direct-conversion transceiver, RF synthesizer and VCO,
and high-speed data converters. Digital interface is used for transferring the sampled data between radio
and baseband chip. The baseband chip implements OFDM/CCK digital baseband processor and ARM9- based
MAC with internal SRAM memories. The baseband includes required logic and interfaces to enable time-shared
simultaneous use of BT and WLAN.

The energy management unit integrates required power management functions to operate the system from
VBAT (3.0 – 5.5 V). The EM unit generates 1.2 V digital core voltage, two 1.8 V supplies for RF and 2.8 V LDO
for PA bias supply. The EM unit also integrates power-on reset circuitry and level-shifters for RF front-end
GaAs switches.

Host interface is provided by a flexible serial interface (SPI) supporting clock frequency upto 48 MHz. The
maximum usable SPI clock rate depends on the host side clocking options and timing requirements. Typically
rates of 14 – 24 MHz are achieved. WLAN/BT coexistence interface enables automatic time shared usage of
WLAN and Bluetooth.

The system uses 38.4 MHz reference clock. In this device, a dedicated oscillator circuit for WLAN and bluetooth
reference clock is used. Low power sleep mode operation is enabled using 32768Hz low speed clock and
energy management stand-by state.
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WLAN RFMD RF5924 front end module is used. Power amplifier, RF-switches and baluns are integrated to
FEM. The PA includes power detector for closed-loop power control purposes. WLAN/BT bandpass filter is
external ceramic filter.

Table 8 General WLAN specifications

Supported channels USA 1-11 (2412-2462MHz)

ETSI 1-13 (2412-2472MHz)

Barker/CCK (1, 2, 5.5, 11Mbps datarate)

OFDM-BPSK (6, 9 Mb/s)

OFDM-QPSK (12, 18 Mb/s)

OFDM-16QAM (24, 36 Mb/s)

OFDM-64QAM (48, 54 Mb/s)

12 dBm

10 dBm

10 dBm

9 dBm

9 dBm

Power control range 0-17dBm

Receiver sensitivity (typical)

11M/bits. 1024bytes / 8% PER

54 Mb/s, 1000 bytes, 10% PER

-83dBm

-70dBm

 USB
USB (Universal Serial Bus) provides a wired connectivity between a PC and peripheral devices. It is a differential
serial bus.

USB 2.0 is supported with full speed (12 Mbps).

Hot swap is supported, which means that USB devices may be plugged in/out at any time.

This phone is provided with a specific connector for microUSB.
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 CBUS interface
CBUS is a "main" system control bus in BB5. RAPIDO controls the functionality of EM ASIC (N2200) and EM ASIC
(N2300) ASICs with CBUS.

CBUS is a four-wire half-duplex master-slave interface. In BB5 CBUS clock frequency is 2.4 MHz.

 FBUS
USB and FBUS have multiplexed interface between EM ASIC (2300) and RAPIDO.

 ECI interface
The ECI (Enhancement Control Interface) is a point-to-point, bi-directional, single line serial bus.

The purpose of the ECI is to identify and authenticate the accessory, and to act as a data bus (intended for
control purposes) between the phone and the accessory .

 Charger interface
Charging control and charge switch are situated in EM ASIC (N2300).

If the temperature rises too high and the thermal protection is activated, EM ASIC (N2300) goes to protection
mode.

 SIM interface
The device has one SIM (Subscriber Identification Module) interface. It is only accessible if battery is removed.
The SIM interface consists of an internal interface between RAPIDO and EM ASIC (N2200), and of an external
interface between N2200 and SIM contacts.

The SIM IF is shown in the following figure:

Figure 58 SIM interface

The EM ASIC handles the detection of the SIM card. The detection method is based in the BSI line. Because of
the location of the SIM card, removing the battery causes a quick power down of the SIM IF.

RM-179; RM-223
System Module and User Interface

Page 6 –18 COMPANY CONFIDENTIAL Issue 1
Copyright © 2007 Nokia. All rights reserved.



The EM ASIC SIM1 interface supports both 1.8 V and 3.0 V SIM cards. The SIM interface voltage is first 1.8 V
when the SIM card is inserted, and if the card does not response to the ATR a 3 V interface voltage is used.
The data communication between the card and the phone is asynchronous half duplex, and the clock supplied
to the card is 1-5 MHz, which is 3.2 MHz by default (in GSM system). The data baud rate is the SIM card clock
frequency divided by 372 (by default), 64, 32 or 16.

 µSD card interface

Figure 59 SD interface

The µSD card is connected to the engine by an external level shifter with an ESD protection filter. Supplied
voltages:

• VSD: 2.85 V (from level shifter)

• VIO: 1.8 V (from AVILMA)

The µSD card door state is detected by a detect switch. When the door is open, the uSD card is powered off.
Hot swap is supported, which means that the card may be plugged in/out at any time, without removing the
battery.

 Camera concept

Cameras
The device has two integrated digital cameras. The main camera is meant for high quality still imaging and
video capture. The secondary (front) camera is meant for video conferencing but it can also be used for still
image capture.

Main camera characteristics

Sensor type CMOS
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Sensor photo detectors 2.0 Million (1600 x 1200 pixels)

F number/Aperture f/2.8

Focal length 4.4 mm

Focus range 40 cm to infinity

Still Image resolutions 1600x1200, 1152x864 and 640x480

Still images file format EXIF (JPEG), *.jpg

Video resolutions 320x240, 176x144 and 128x96

Video clip length 30 sec short mode or 1 hour free mode

Video file format 3GPP, (*.3gp)

Exposure control Automatic

White balance Automatic, sunny, cloudy, incandescent, flurescent

Colour tones Normal, sepia, vivid, black&white, negative

Capture Modes Still capture mode, video mode and sequence mode

Selftimer 10, 20, 30 s

Flash settings Auto, off and forced

Figure 60 Main camera image orientation

Secondary camera characteristics

Sensor type CMOS

Sensor photo detectors (effective) 384x320

F number/Aperture 2.8
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Focus range 25cm -> 1m

Still image resolutions 320x240

Still images format EXIF (.jpg)

Video resolutions 352x288, 176x144 or 128x96

Video clip length 30sec short mode or 1 hour free mode

Video file format 3GPP, (*.3gp)

White Balance Automatic

Colours 16.7 Million, 24bit

Figure 61 Secondary camera mechanical outline

Camera flash
The device back camera has a camera flash module located directly beside the camera, providing better
lighting conditions in darker environments. The indicator LED close to the flash module is used as an indicator
light for certain use cases.

The camera flash is a single die, ultra compact light sources. Therefore the LED does not include lens. It is
part of the phone cover to ensure a proper light pattern at the target.

The dimensions of the camera flash module are 1.65 ± 0.1 mm x 2.05 ± 0.1 mm x 0.7 mm.
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Figure 62 Flash LED
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Hardware accelerator
The STV0984N is an ultra low power mobile imaging digital signal processor which supports SMIA CMOS color
image sensors up to 2 Megapixel resolution. It performs all the required data processing to deliver good
quality in view finder, still and movie color images.

The STV0984N performs high quality color processing on images, achieving JPEG compression if requested
by Rapido. Further, it includes programmable GPIOs to control external flash LED. STV0984 provides internal
buffering capability along with a versatile clock manager to accommodate different data rates between input
sensors and Rapido interface.

Data is transferred from sensor to STV0984N through Low Electromagnetic Interference (EMI) interface; using
the CCP 2.0 data transfer protocol over LVDS (2 separate CCP 2.0 receivers).
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Figure 63 Camera overview

 User interface

Display module
This phone has one display:

• Active TFT QVGA display supports up to 16,777,216 colors (320 x 240 pixels, 2.2 inches)

The display is connected to Rapido MeSSI interface. Signal filtering is done via LCD-ASIP components placed
on engine PWB. The MeSSI interface is operated with 8.77 MHz.
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Figure 64 Display overview
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Display characteristics

Table 9 Display characteristics

Item Specification

Active area resolution 240x320 (166ppi)

Interface MeSSI-8/16 with 8 bit data IF

Number of colors 24bit (normal mode)

3bit (partial mode)

Size 41,8mm x 59,4mm x 2mm

Illumination 2x2 white LEDs

230 mcd

Viewing angle 3,6,9,12 o’clock

Technology AM-LCD

Figure 65 Display mechanical outline

Keyboard and other keys
The keyboard interface of the Rapido supports a 8x8 keyboard matrix. In this phone two 4x4 sub matrixes
are used. One for the ITUT keys (Row4-7/Collumn4-7) on the ITUT flex. The other is used for the S60/music
keys (Row0-3/Collumn0-3) on the slide FPC. Both matrixes are protected by ASIPs on the engine PWB.
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Figure 66 ITUT and S60 keymat

Figure 67 S60 and Menue flex
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Figure 68 RM-179 key matrix

Backlight and illumination

Display and menu key illumination

Display
The display has 2x2 LEDs in series included for backlight illumination. They are connected to have 4 LEDs in
series and driven with a constant current source SMPS (N2301). Driving current is 15mA and its PWM dimmed
(EN). In addition a “load-disconnect” circuit (N2302) is implemented. This avoids ringing of the output
capacity C2314. Basic filtering on VLEDOUT is done with L2302, C2305 and C2316.

Menu keys
Three LED chains for S60 Keys, Music Keys and Gaming Keys are derived from VLEDOUT and driven by a constant
current source at 5 mA. Each chain has separate ENABLE signal and dimmed with VLEDOUT. Gaming Key LEDs
have additional ESD protection.
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Figure 69 Illumination overivew

ITUT keyboard and side key illumination
ITUT keyboard is illuminated with 2x2 LEDs in parallel and side keys are illuminated with 1x2 LEDs in parallel.
Each two LEDs are driven by a High-Side driver output (N2302) with 10mA which results in 5mA per LED. ITUT-
LEDs are connected to channel A and side-LEDs are connected to channel B. Each channel can be separately
switched on and off (ENA, ENB). Both channels are ORed (D2400) with PWM signal to achieve dimming when
display is dimmed.
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Figure 70 ITUT keyboard and side key backlight

NaviWheel illumination (power LED)
The NaviWheel illumination has three LEDs in parallel and driven in two modes: S60 and Power-Save mode.

In S60 mode driving current is 15mA with gives 5mA per LED. It is activated whenever S60 LEDs of menu
keyboard are activated. In this mode dimming is not supported.

In order to save current and increase the standby time, the phone provides an extra power saving mode
where the display will be switched off after a certain time of user inactivity. A low frequently blinking
NAVIWheel will indicate, that the phone is still alive (no empty battery). In Power-Save mode driving current
is 6mA which will lead to 2mA per LED.

RM-179; RM-223
System Module and User Interface

Page 6 –30 COMPANY CONFIDENTIAL Issue 1
Copyright © 2007 Nokia. All rights reserved.



Figure 71 High side driver schematic

Hall sensor
The hall sensor is for the open/closed slider detection. The sensor that is mounted on the engine PWB works
together with a magnet on the slide FPC module.

RM-179; RM-223
System Module and User Interface

Issue 1 COMPANY CONFIDENTIAL Page 6 –31
Copyright © 2007 Nokia. All rights reserved.



Figure 72 Hall sensor connection

 ASICs

RAPIDO ASIC
Rapido ASIC is a 3G Radio Application Processor.

EM ASIC N2300
The EM ASIC (N2300) includes the following functional blocks:

• Core supply generation

• Charge control circuitry

• Level shifter and regulator for USB/FBUS

• Current gauge for battery current measuring

• LED driver for backlights

• Digital interface (CBUS)

EM ASIC N2200
The EM ASIC (N2200) includes the following functional blocks:

• Start up logic and reset control

• Charger detection

• Battery voltage monitoring
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• 32.768kHz clock with external crystal

• Real time clock with external backup battery

• SIM card interface

• Stereo audio codecs and amplifiers

• A/D converter

• Regulators

• Vibra interface

• Digital interface (CBUS)

EMC ASIP (Appcation Specified Integrated Passive) have been integrated inside the ASIC. It includes biasing
passives for microphone , EMC filter for SIM, microphones etc.

 Combo memory
The application memory of the device consists of NAND/DDR combo memory. The stacked DDR/NAND
application memory has 768 Mbit of DDR memory and 1 Gbit of flash memory.

 Audio concept

Audio HW architecture
The functional core of the audio hardware is built around the two ASICs Rapido engine and mixed signal ASIC
AVILMA.

AVILMA provides an interface for the transducers and accessory connector. Integrated handsfree stereo
speakers are driven by a Class-D audio amplifier TPA2012D2 (second source LM4674A). An audio DAC AIC33
and audio amplifier TPA6130A2 (or second source TS4601) are used to supply HiFi audio signals to external
headphone/headset.

The audio transducers are:

• Dynamic earpiece (located on slider)

• Two dynamic speakers

• Digital microphone

In addition to the audio transducers, AVILMA also provides an output for the dynamic vibra component.

All galvanic audio accessories are connected to AV accessory connector.

A Bluetooth audio and FM-radio module, connected to Rapido, AVILMA and AIC33 supports Bluetooth audio
and radio functionality.
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Internal microphone
Internal microphone is used for Handportable (HP) and Internal Handsfree (IHF) call modes.

A digital MEMS-microphone is connected directly to Rapido via Data (MicData on Genio42) and CLK (AudioCLK).
Mic is powered by VSIM2.

Figure 73 Internal microphone circuitry

External microphone
Headsets provide external analog microphone via AV connector.
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Accessory audio mode is automatically enabled/disabled during connection/disconnection of dedicated
phone accessories.

External mic uses AVILMA (N2200) Mic2P and Mic2N inputs. External mic circuitry is biased by AVILMAs MicB2
bias voltage output. This bias voltage is filtered by R2207 and C2202 and the fed through R2200.

Figure 74 MicBias circuitry

Figure 75 External mic circuitry

Internal earpiece
Internal earpiece is used for Handportable (HP) call mode. A dynamic earpiece is connected to AVILMA via
slide FPC 1YZ in slider.
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Figure 76 AVILMA output

Figure 77 Connector X3800 to Flexboard

Figure 78 Connection to earpiece on slide FPC board

Internal speakers
Internal speakers are used for Internal Handsfree (IHF) call mode, Video call, ringing tones, FM radio and
music listening.

Two dynamic speakers are connected to AVILMA’s outputs Xear left and right in differential mode with a
highpassfilter (C2158/R2150 and C2159/R2151) and a stereo calss D amplifier TPA2012D2 with a fixed gain
of 12dB. Amplifier is shut down if not in use.
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Figure 79 Internal speaker circuitry

External earpiece
All galvanic accessories are connected to av connector (except for USB-devices).

The accessory audio mode is automatically enabled/disabled during connection /disconnetction of dedicated
phone accessories.

The Rapido ASIC provides the I2S digital interface for AIC33. Rapido controls and supplies a signal for AIC33
digitally. AIC33 output is directed to AV connector through audio amplifier TPA6130.
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Figure 80 AV connector circuitry

Vibra circuitry
Vibra is used for Vibra alarm function.

The vibra motor is connected to AVILMA asic VibraP and VibraN pulse width modulated outputs through Filter.
Vibra is built into cover and connected via cable to plug on PWB.

Figure 81 Vibra circuitry

AV connector
The AV Connector consists of single ended mono or stereo audio output and mono audio input.

The following table shows the AV interface electrical characteristics.

Table 10 AV interface electrical characteristics

Signal
name

Function/
Parameter

Min Typ Max Unit Note

HSMIC HS mic audio
input

- - 1,3 Vpp Max neg level
0,7V
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Signal
name

Function/
Parameter

Min Typ Max Unit Note

HSEARL*) HS Ear L audio
output

- - 2 Vpp SPR
requirement

HSEARR*) HS Ear R audio
output

- - 2 Vpp SPR
requirement

Micbias HS MIcbias
Voltage

2,05 2,1 2,25 V

ECI Vin high 1,7 - 2,6 V

ECI Vin low 0 - 0,7 V

*) Non EU variants have +6dB higher max level (double max value)

 Baseband technical specifications

External interfaces

Name of connection Connector reference

USB X2030 (on engine PWB)

Charger plug X2000

AV connector (Headset) X2001 (on engine PWB)

SIM reader X2700 (on engine PWB)

Micro SD reader X3200 (on engine PWB)

Battery connector X2070 (on engine PWB)

SIM IF connections

Pin Signal I/O Engine connection Notes

C1 VSIM Out EM ASIC N2200 VSIM1 Supply voltage to SIM card, 1.8V or
3.0V.

C2 SIMRST Out EM ASIC N2200 SIMRstC1 Reset signal to SIM card

C3 SIMCLK Out EM ASIC N2200 SIMClkC1 Clock signal to SIM card

C5 GND - GND Ground

C7 SIMDATA In/Out EM ASIC N2200 SIMDaC1 Data input /output
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Charger connector and charging interface connections & electrical characteristics

Figure 82 Charger connector

Table 11 Charging interface connections

Pin Signal I/O Engine connection Notes

1 Vchar In N2300 VCharIn1

VCharIn2

VCharInK

Charging voltage / charger detection,
Center pin

2 Charge GND Ground Charger ground

Table 12 Charging IF electrical characteristics

Description Parameter Min Max Unit Notes

Vchar V Charge 0 16 V Limit is given by suppressor diode

Vchar I Charge 1.1 A Value valid for PWM mode charge current

Charge GND 1.1 A Value valid for PWM mode charge current

Internal interfaces

Name of Connection Connector reference Module

IHF speaker connector (right/left) B2150/B2151 Engine assembly

Microphone connector B2170 Engine assembly

BTB connector (Slide FPC) X3800 Engine assembly

BTB connector on Slide FPC X1000 Slide FPC

BTB connector (ITUT FPC) X2400 Engine assembly

BTB connector on ITUT FPC X1500 ITUT FPC
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Name of Connection Connector reference Module

BTB connector (BT FPC) X2520/X2521/X6300/
X6302

Engine assembly

BTB connector on BT FPC X1000/X1001/X1002 BT FPC

Main camera connector X2500 Engine assembly

Vibra connector X2100 Engine assembly

Display connector X1010 Slide FPC

Earpiece connector B1010 Slide FPC

Back-up battery interface electrical characteristics

Table 13 Back-up battery connections

Pin name I/O Connection Notes

VBACK <-> N2200 -
VBACK

Back-up battery G2200 is connected to
N2200 directly

Table 14 Back-up battery electrical characteristics

Description Parameter Min Typ Max Unit

Back-Up Battery Voltage Vback 2.6 V
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 RF description

Block diagram

Figure 83 RF block diagram using RF ASIC N7505

The RF block diagram uses RF ASIC N7505 that performs the RF back-end functions of receive and transmit
function of the cellular transceiver.

Receiver (RX)
An analogue signal is received by the phone's antenna. The signal is converted to a digital signal and is then
transferred further to the baseband (eg. to the earpiece).

The receiver functions are implemented in the RF ASIC.

Signals with different frequencies take different "ways", being handled by different components. The
principle of GSM and WCDMA is the same.
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Transmitter (TX)
The digital baseband signal (eg. from the microphone) is converted to an analogue signal, which is then
amplified and transmitted from the antenna. The frequency of this signal can be tuned to match the
bandwidth of the system in use (eg. GSM900).

The transmitter functions are implemented in the RF ASIC.

Even though the GSM and WCDMA signals pass different components, the principles of the transmission is the
same.
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 Frequency mappings

GSM850 frequencies
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EGSM900 frequencies
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GSM1800 frequencies
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GSM1900 frequencies
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WCDMA 2100 Rx frequencies
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WCDMA 2100 Tx frequencies
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A/D-converter Analog-to-digital converter

ACI Accessory Control Interface

ADC Analog-to-digital converter

ADSP Application DPS (expected to run high level tasks)

AGC Automatic gain control (maintains volume)

ALS Ambient light sensor

AMSL After Market Service Leader

ARM Advanced RISC Machines

ARPU Average revenue per user (per month or per year)

ASIC Application Specific Integrated Circuit

ASIP Application Specific Interface Protector

B2B Board to board, connector between PWB and UI board

BB Baseband

BC02 Bluetooth module made by CSR

BIQUAD Bi-quadratic ,type of filter function)

BSI Battery Size Indicator

BT Bluetooth

CBus MCU controlled serial bus connected to UPP_WD2,UEME and Zocus

CCP Compact Camera Port

CDSP Cellular DSP (expected to run at low levels)

CLDC Connected limited device configuration

CMOS Complimentary metal-oxide semiconductor circuit (low power consumption)

COF Chip on Foil

COG Chip on Glass

CPU Central Processing Unit

CSR cambridge silicon radio

CSTN Color Super Twisted Nematic

CTSI Clock Timing Sleep and interrupt block of Tiku

CW Continuous wave

D/A-converter Digital-to-analouge converter

DAC Digital-to-analouge converter

DBI Digital Battery Interface

DBus DSP controlled serial bus connected between UPP_WD2 and Helgo

DCT-4 Digital Core Technology

DMA Direct memory access

DP Data Package
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DPLL Digital Phase Locked Loop

DSP Digital Signal Processor

DtoS Differential to Single ended

EDGE Enhanced data rates for global/GSM evaluation

EGSM Extended GSM

EM Energy management

EMC Electromagnetic compability

EMI Electromagnetic interference

ESD Electrostatic discharge

FCI Functional cover interface

FPS Flash Programming Tool

FR Full rate

FSTN Film compensated super twisted nematic

GMSK Gaussian Minimum Shift Keying

GND Ground, conductive mass

GPIB General-purpose interface bus

GPRS General Packet Radio Service

GSM Group Special Mobile/Global System for Mobile communication

HF Hands free

HFCM Handsfree Common

HS Handset

HSCSD High speed circuit switched data (data transmission connection faster than GSM)

HW Hardware

I/O Input/Output

IBAT Battery current

IC Integrated circuit

ICHAR Charger current

IF Interface

IHF Integrated hands free

IMEI International Mobile Equipment Identity

IR Infrared

IrDA Infrared Data Associasion

ISA Intelligent software architecture

JPEG/JPG Joint Photographic Experts Group

LCD Liquid Crystal Display

LDO Low Drop Out
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LED Light-emitting diode

LPRF Low Power Radio Frequency

MCU Micro Controller Unit (microprocessor)

MCU Multiport control unit

MIC, mic Microphone

MIDP Mobile Information Device Profile

MIN Mobile identification number

MIPS Million instructions per second

MMC Multimedia card

MMS Multimedia messaging service

NTC Negative temperature coefficient, temperature sensitive resistor used as a
temperature sensor

OMA Object management architechture

OMAP Operations, maintenance, and administartion part

Opamp Operational Amplifier

PA Power amplifier

PDA Pocket Data Application

PDA Personal digital assistant

PDRAM Program/Data RAM (on chip in Tiku)

Phoenix Software tool of DCT4.x and BB5

PIM Personal Information Management

PLL Phase locked loop

PM (Phone) Permanent memory

PUP General Purpose IO (PIO), USARTS and Pulse Width Modulators

PURX Power-up reset

PWB Printed Wiring Board

PWM Pulse width modulation

RC-filter Resistance-Capacitance filter

RF Radio Frequency

RF PopPort TM Reduced function PopPortTM interface

RFBUS Serial control Bus For RF

RSK Right Soft Key

RS-MMC Reduced size Multi Media Card

RSSI Receiving signal strength indicator

RST Reset Switch

RTC Real Time Clock (provides date and time)
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RX Radio Receiver

SARAM Single Access RAM

SAW filter Surface Acoustic Wave filter

SDRAM Synchronous Dynamic Random Access Memory

SID Security ID

SIM Subscriber Identity Module

SMPS Switched Mode Power Supply

SNR Signal-to-noice ratio

SPR Standard Product requirements

SRAM Static random access memory

STI Serial Trace Interface

SW Software

SWIM Subscriber/Wallet Identification Module

TCXO Temperature controlled Oscillator

Tiku Finnish for Chip, Successor of the UPP

TX Radio Transmitter

UART Universal asynchronous receiver/transmitter

UEME Universal Energy Management chip (Enhanced version)

UEMEK See UEME

UI User Interface

UPP Universal Phone Processor

UPP_WD2 Communicator version of DCT4 system ASIC

USB Universal Serial Bus

VBAT Battery voltage

VCHAR Charger voltage

VCO Voltage controlled oscillator

VCTCXO Voltage Controlled Temperature Compensated Crystal Oscillator

VCXO Voltage Controlled Crystal Oscillator

Vp-p Peak-to-peak voltage

VSIM SIM voltage

WAP Wireless application protocol

WD Watchdog

XHTML Extensible hypertext markup language

Zocus Current sensor, (used to monitor the current flow to and from the battery)
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